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Garantie 2

Tektronix garantiert, dass dieses Produkt fiir einen Zeitraum von einem (1) Jahr ab Versanddatum keine Fehler in Material und
Verarbeitung aufweist. Wenn ein Produkt innerhalb dieser Garantiezeit Fehler aufweist, steht es Tektronix frei, dieses fehlerhafte
Produkt kostenlos zu reparieren oder einen Ersatz fiir dieses fehlerhafte Produkt zur Verfiigung zu stellen. Von Tektronix fiir
Garantiezwecke verwendete Teile, Module und Ersatzprodukte kdnnen neu oder in ihrer Leistung neuwertig sein. Alle ersetzten
Teile, Module und Produkte werden Eigentum von Tektronix.

Um mit dieser Garantie Kundendienst zu erhalten, muss der Kunde Tektronix tiber den Fehler vor Ablauf der Garantiezeit informieren
und geeignete Vorkehrungen fiir die Durchfiihnrung des Kundendienstes treffen. Der Kunde ist fiir die Verpackung und den Versand
des fehlerhaften Produkts an die Service-Stelle von Tektronix verantwortlich, die Versandgebiihren miissen im Voraus bezahlt sein.
Tektronix Ubernimmt die Kosten der Riicksendung des Produkts an den Kunden, wenn sich die Versandadresse innerhalb des Landes
der Tektronix Service-Stelle befindet. Der Kunde tbernimmt alle Versandkosten, Fracht- und Zollgebiihren sowie sonstige Kosten

fur die Ricksendung des Produkts an eine andere Adresse.

Diese Garantie tritt nicht in Kraft, wenn Fehler, Versagen oder Schaden auf die falsche Verwendung oder unsachgemafe und falsche
Wartung oder Pflege zurlickzufiihren sind. Tektronix muss keinen Kundendienst leisten, wenn a) ein Schaden behoben werden

soll, der durch die Installation, Reparatur oder Wartung des Produkts von anderem Personal als Tektronix-Vertretern verursacht
wurde; b) ein Schaden behoben werden soll, der auf die unsachgemafie Verwendung oder den Anschluss an inkompatible Geréate
zurlickzufihren ist; ¢) Schaden oder Fehler behoben werden sollen, die auf die Verwendung von Komponenten zurlickzufihren sind,
die nicht von Tektronix stammen; oder d) wenn ein Produkt gewartet werden soll, an dem Anderungen vorgenommen wurden oder
das in andere Produkte integriert wurde, so dass dadurch die aufzuwendende Zeit fir den Kundendienst oder die Schwierigkeit der
Produktwartung erhdht wird.

DIESE GARANTIE WIRD VON TEKTRONIX FUR DAS PRODUKT ANSTELLE ANDERER AUSDRUCKLICHER ODER IMPLIZITER
GARANTIEN GEGEBEN. TEKTRONIX UND SEINE HANDLER SCHLIESSEN AUSDRUCKLICH ALLE GARANTIEN HINSICHTLICH
DER HANDELSGANGIGKEIT UND DER EIGNUNG FUR EINEN BESTIMMTEN ZWECK AUS. FUR TEKTRONIX BESTEHT DIE
EINZIGE UND AUSSCHLIESSLICHE VERPFLICHTUNG DIESER GARANTIE DARIN, FEHLERHAFTE PRODUKTE FUR DEN
KUNDEN ZU REPARIEREN ODER ZU ERSETZEN. TEKTRONIX UND SEINE HANDLER UBERNEHMEN KEINERLEI HAFTUNG
FUR DIREKTE, INDIREKTE, BESONDERE UND FOLGESCHADEN, UNABHANGIG DAVON, OB TEKTRONIX ODER DER
HANDLER VON DER MOGLICHKEIT SOLCHER SCHADEN IM VORAUS UNTERRICHTET IST.
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Allgemeine Sicherheitshinweise

Allgemeine Sicherheitshinweise

Beachten Sie zum Schutz vor Verletzungen und zur Verhinderung von Schaden an diesem Gerat oder an damit verbundenen
Geraten die folgenden Sicherheitshinweise.

Verwenden Sie dieses Gerat nur gemal der Spezifikation, um jede mdgliche Gefahrdung auszuschlieen.
Wartungsarbeiten sind nur von qualifiziertem Personal durchzufiihren.

Wahrend der Verwendung des Gerats missen Sie eventuell auf andere Teile eines umfassenderen Systems zugreifen.
Beachten Sie die Sicherheitsangaben in Handblchern fiir andere Komponenten beziiglich Warn- und Vorsichtshinweisen
zum Betrieb des Systems.

Verhiitung von Branden und Verletzungen

Verwenden Sie ein ordnungsgemaBes Netzkabel. Verwenden Sie nur das mit diesem Produkt ausgelieferte und
fir das Einsatzland zugelassene Netzkabel.

SchlieRen Sie das Gerat ordnungsgemal an. Trennen oder schlieRen Sie keine Tastkopfe oder Priffleitungen
an, wahrend diese an einer Spannungsquelle anliegen.

SchlieRen Sie das Gerat ordnungsgemaR an. Unterbinden Sie die Stromzufuhr fiir den Messpunkt, bevor Sie den
Tastkopf anschliefen oder vom Gerét trennen.

Erden Sie das Produkt. Das Gerét ist liber den Netzkabelschutzleiter geerdet. Zur Verhinderung von Stromschlégen
muss der Schutzleiter mit der Stromnetzerdung verbunden sein. Vergewissern Sie sich, dass eine geeignete Erdung besteht,
bevor Sie Verbindungen zu den Eingangs- oder Ausgangsanschliissen des Gerats herstellen.

Beachten Sie alle Angaben zu den Anschliissen. Beachten Sie zur Verhiitung von Brénden oder Stromschlagen
die Kenndatenangaben und Kennzeichnungen am Gerat. Lesen Sie die entsprechenden Angaben im Geratehandbuch,
bevor Sie das Gerat anschlieflen.

Die Eingange sind nicht fiir Anschliisse an Hauptstromkreise oder Schaltkreise der Kategorien Il, Il und IV ausgelegt.
SchlieRen Sie einen Tastkopf nicht an eine Leitung an, deren Spannung die Nennspannung des Tastkopfes iiberschreitet.

Trennen vom Stromnetz. Der Netzschalter trennt das Gerét von der Stromversorgung. Weitere Anweisungen zur
Positionierung des Schalters finden Sie in der Dokumentation. Blockieren Sie den Netzschalter nicht, da er fiir die Benutzer
jederzeit zuganglich sein muss.

SchlieRen Sie die Abdeckungen. Nehmen Sie das Gerét nicht in Betrieb, wenn Abdeckungen oder Geh&useteile
entfernt sind.

Bei Verdacht auf Funktionsfehler nicht betreiben. Wenn Sie vermuten, dass das Gerat beschadigt ist, lassen
Sie es von qualifiziertem Wartungspersonal Uberpriifen.

Vermeiden Sie offen liegende Kabel. Beriihren Sie keine freiliegenden Anschliisse oder Bauteile, wenn diese unter
Spannung stehen.

Verwenden Sie die richtige Sicherung. Verwenden Sie nur Sicherungen des fiir dieses Gerat angegebenen Typs.
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Allgemeine Sicherheitshinweise

Nicht bei hoher Feuchtigkeit oder Nasse betreiben.
Nicht in Arbeitsumgebung mit Explosionsgefahr betreiben.
Sorgen Sie fiir saubere und trockene Produktoberflachen.

Sorgen Sie fiir die richtige Kiihlung. Weitere Informationen tiber die Gewahrleistung einer ordnungsgemaien Kiihlung
fir das Produkt erhalten Sie im Handbuch.

Begriffe in diesem Handbuch

In diesem Handbuch werden die folgenden Begriffe verwendet:

c WARNUNG. Warnungen weisen auf Bedingungen oder Verfahrensweisen hin, die eine Verletzungs- oder Lebensgefahr
darstellen.

VORSICHT. Vorsichtshinweise machen auf Bedingungen oder Verfahrensweisen aufmerksam, die zu Schaden am Gerét
oder zu sonstigen Sachschéden fiihren kénnen.

Symbole und Begriffe am Gerat
Am Gerét sind eventuell die folgenden Begriffe zu sehen:
®  GEFAHR weist auf eine Verletzungsgefahr hin, die mit der entsprechenden Hinweisstelle unmittelbar in Verbindung steht.

m  WARNUNG weist auf eine Verletzungsgefahr hin, die nicht unmittelbar mit der entsprechenden Hinweisstelle in
Verbindung steht.

m  VORSICHT weist auf mdgliche Sach- oder Gerateschaden hin.

Am Gerét sind eventuell die folgenden Symbole zu sehen:

A A @ O

VORSICHT WARNUNG Schutzleiteranschluss
Beachten Sie die Hochspannung (Erde) Standby
Hinweise im Handbuch
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Vorwort

Vorwort

In diesem Handbuch werden die Installation und die Bedienungsgrundlagen der Videomesssysteme der Serie VM
beschrieben. Weitere Informationen finden Sie in der Online-Hilfe fiir das Instrument und im Benutzerhandbuch fiir
Videomesssysteme der Serie VM.

Hauptfunktionen

Bei den Videomesssystemen der Serie VM handelt es sich um Hochleistungs-Videomesssysteme auf der Basis einer
Ostzilloskopplattform. Sie zeichnen sich durch die folgenden Leistungsmerkmale aus:

m  Schnelle, genaue und verlassliche Videomessungen

B Umfassende Analyse fiir analoge Komponentensignale

= Automatische Priifung von PC- und DTV-Heimvideogeraten

= Automatische VESA-Komformitatspriifung fiir PC-Grafikgerate

m  Unterstitzt analoge SD-, HDTV- und RGBHV-Videoformate tiber Optionen
B Bild-, Vektor- und Signalanzeigen

m Integrierte Pass/Fehler-Grenzwertpriifung

= Handbuch fiir Priifsignalpakete

m  GPIB-Fernsteuerung und LAN-Anschluss

B Umfassende Oszilloskopfunktionalitat

Unterstiitzte Produkte

Videomesssysteme der Serie VM sind als Software- und Hardwarepaket erhaltlich. Sie konnen das Paket auf
Tektronix-Oszilloskopen installieren, die Sie bereits besitzen, oder die Systeme VM5000HD oder VM5000 damit aufriisten. In
der folgenden Tabelle finden Sie eine Aufstellung der Produkte, die von den Videomesssystemen der Serie VM unterstiitzt
werden. Beachten Sie, dass einige Produkte die VGA-Option nicht unterstiitzen.

Instrument Unterstiitzte Optionen
VM5000HD SD, HD und VGA
VM5000 SD, HD und VGA

TDS 5104 SD, HD und VGA

TDS 5104B SD, HD und VGA

TDS 5054 SD und HD

TDS 5054B SD und HD

DPO 7254 SD, HD und VGA

DPO 7104 SD, HD und VGA

DPO 7054 SD und HD
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Dokumentation

Informationen Dokumente

Installation und Betrieb (Ubersicht) Schnellstart-Benutzerhandbuch fiir Videomesssysteme der Serie VM.
Das Schnellstart-Benutzerhandbuch enthélt allgemeine Informationen
Uber die Inbetriebnahme des Instruments, einen Leitfaden fir
Benutzeroberflachen-Steuerelemente sowie Anwendungsbeispiele.

Ausfiihrliche Hilfe fiir den Betrieb und die Benutzerhandbuch fiir Videomesssysteme der Serie VM. Das

Benutzeroberflache Benutzerhandbuch enthalt ausfiihrliche Informationen iiber den Betrieb
des Instruments. Hierzu gehdren auch Angaben zur Berechnung von
Messungen sowie technische Daten.

Online-Hilfe fiir Videomesssysteme der Serie VM. Greifen Sie Uber das
Hilfemenii der Software auf die Online-Hilfe zu, um Informationen zu den
Bedienelementen und Elementen auf dem Bildschirm zu erhalten.

Programmierbefehle Programmierhandbuch fiir Videomesssysteme der Serie VM. Die speziell
fur die Videomesssysteme der Serie VM geltenden Programmierbefehle
sind in einer PDF-Datei auf der Produktsoftware-CD fiir das System
aufgefuhrt. Beim Programmierhandbuch fiir das Oszilloskop handelt es
sich um eine PDF-Datei auf der Produktsoftware-CD .

Einsatz des Oszilloskops Umfassende Informationen zur Verwendung der Oszilloskopfunktionen
finden Sie in der Dokumentation fiir das jeweilige Oszilloskop.

Benutzerservice und Leistungspriifung Informationen finden Sie im Wartungshandbuch fiir das Oszilloskop.

Softwareaktualisierungen

Gelegentlich konnen Softwareaktualisierungen verflighar gemacht werden. Die Software kann nur in Verbindung mit einem
glltigen Optionsschliissel fiir das jeweilige Oszilloskopmodell und die betreffende Seriennummer verwendet werden.

So suchen Sie nach Aktualisierungen:
1. Navigieren Sie zur Tektronix-Website (www.tektronix.com).

2. Wahlen Sie Software and Drivers (Software und Treiber) aus, um die Webseite Software and Firmware Finder
(Software- und Firmware-Suche) aufzurufen.

3. Geben Sie den Produktnamen (Serie VM) ein, um nach verfiigbaren Softwareaktualisierungen zu suchen.
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In diesem Handbuch verwendete Konventionen

In diesem Handbuch wird der Umgang mit den Optionen SD, HD und VGA der Videomesssysteme der Serie VM beschrieben.
Obwohl die Betriebsverfahren fiir alle drei Optionen identisch sind, gibt es einige Unterschiede hinsichtlich der Funktionen,
vor allem bezUglich der verfligbaren Messungen. Die Software und das Zubehr fir die Videomesssysteme der Serie VM
sind zudem fir die Installation auf ausgewahlten Tektronix-Oszilloskopen erhéltlich. Unterschiede in der Konfiguration bzw.
in der Anwendung werden im Text durch Angabe der Oszilloskopplattform oder der Option kenntlich gemacht, fiir die sie
gelten. Bei Unterschieden in der Bildschirmanzeige werden beide Versionen angezeigt (Option SD/HD und Option VGA).

Die folgenden Symbole werden in diesem Handbuch verwendet.

Verfahrenss- Netzschalter Netzan- Netzwerk pPS2 SVGA USB
chritt auf der schluss
Frontplatte

° DO OO OO
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Installation des Geréts

Installation des Gerats

In diesem Abschnitt finden Sie Informationen zur Installation lhres Instruments. Packen Sie das Instrument aus und
Uberpriifen Sie, ob Sie alle als Standardzubehdr angegebenen Teile erhalten haben. Kontrollieren Sie, ob Sie die Teile
des empfohlenen Zubehdrs erhalten haben, die Sie zusammen mit lhrem Instrument bestellt haben. Die aktuellsten
Informationen finden Sie auf der Website von Tektronix (www.tektronix.com).

Standardzubehor

Standardzubehor fiir Videomesssysteme der Serie VM.

Tektronix
Zubehor Bestellnummer
Schnellstart-Benutzerhandbuch fiir das Videomesssystem VM5000 in englischer, franzosischer, 071-2091-XX
deutscher, spanischer, chinesischer (traditionell oder vereinfacht) oder japanischer Ubersetzung,
wenn eine der Sprachoptionen bestellt wurde.
Benutzerhandbuch fiir Videomesssysteme der Serie VM 071-2103-XX
Programmierhandbuch fiir Videomesssysteme der Serie VM im PDF-Format auf der 071-2104-XX
Produktsoftware-CD fir das System
Schnellstart-Benutzerhandbuch fiir die Digitalen Phosphor-Oszilloskope DPO7000, DSA70000 071-1733-xx
und DPO70000
Produktsoftware-CD-ROM fiir das Videomesssystem der Serie VM mit der darin 020-2767-XX
enthaltenen Produktsoftware und Online-Hilfe, dem PDF-Benutzerhandbuch, dem
Schnellstart-Benutzerhandbuch als PDF und den Versionsinformationen fir das
Videomesssystem der Serie VM
Produktsoftware-CD zu DPO7000, DSA70000 und DPO70000 020-2693-xx
CD fir die Wiederherstellung des Betriebssystems zu DPO7000, DSA70000 und DPO70000 020-2659-xx
Tek-Softwarelizenz ,Wiederherherstellung” fiir Wiederherstellungsmedien/Betriebssystemwieder- —
herstellung
CD mit optionaler Anwendungssoftware und Dokumentationssatz 020-2700-xx
Zusammenstellung ,Erste Schritte mit OpenChoice-Ldsungen* 020-2513-xx
Online-Hilfe (Bestandteil der Produktsoftware) zu DPO7000, DSA70000 und DPO70000 —
Leistungspriifung (eine PDF-Datei auf der Produktsoftware-CD)zu DPO7000, DSA70000 und —
DPO70000
Online-Programmieranleitung (Dateien auf der Produktsoftware-CD) zu DPO7000, DSA70000 —
und DPO70000
NIST, Z540-1 und das 1ISO9000-Kalibrierungszertifikat —
Optische Maus 119-7054-xx
Minitastatur, USB mit 2-Port-Hub 118-7083-XX
Frontschutzdeckel 200-4963-xx
Zubehdrbeutel 016-1966-xx
Tastkopfkalibrierung und Deskew-Uberpriifung mit Anweisungen 067-0405-xx
CD mit Nero OEM Software 063-3781-xx
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Installation des Geréts

Standardzubehor fiir Videomesssysteme der Serie VM. (Fortsetzung)

Tektronix
Zubehor Bestellnummer
TPA-BNC Austauschadapter fiir Service 013-0355-02
Option SD & HD - 1 Adapter
Option VGA - 4 Adapter
75 Q-Prézisionsabschliisse (4) 011-0102-XX
BNC-T-Verbinder (4) 103-0030-XX
Sync-Pickoff-Kabel (nur fir Option SD/HD) 012-1680-XX
VGA-zu-5X BNC-Kabel (12,7 cm lang) (nur fur Option VGA) 174-5147-XX
VGA-zu-5X BNC-Kabel (91,4 cm lang) (Nur fiir Option VGA) 174-5216-XX
RGBHV-Messschnittstelleneinheit (nur flir Option VGA) 012-1685-XX
Steuerkabel RS-232 RGBHV MIU (nur fiir Option VGA) 012-1692-XX
BNC-to-Binding-Post-Adapter (2) (Nur fir Option VGA) 011-0183-00
2,21-Kiloohm-Widerstand 322-3226-00
301-Ohm-Widerstand 322-3143-00
VGA Sync Combiner-Kabel 012-1664-XX
Netzkabel Nordamerika (Option A0) 161-0104-00
Europa universal (Option A1) 161-0104-06
GroRbritannien (Option A2) 161-0104-07
Australien (Option A3) 161-0104-05
Schweiz (Option A5) 161-0167-00
Japan (Option A6) 161-A005-00
China (Option A10) 161-0306-00
Indien (Option A11) 161-0324-00

Kein Netzkabel oder Netzteil (Option A99)
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Empfohlenes Zubehor

Das Instrument kann optional auch empfohlenes Zubehér enthalten. Uberpriifen Sie, ob das von lhnen bestellte optionale
Zubehor dem Instrument beigeflgt ist.

Empfohlenes Zubehor fiir Videomesssysteme der Serie VM !

Zubehor Teilenummer
Signalquellen fir Serie VM, 480 Line DVD und 580 Line DVD 020-2770-XX
Signalquellen fiir Serie VM, Elementary Streams in Standardauflésung 020-2771-XX
Signalquellen fiir Serie VM, Elementary Streams fiir hdherwertige Videosignale 020-2772-XX
Signalquellen fiir Serie VM, ATSC-Transportstreams 020-2773-XX
Signalquellen fir Serie VM, Basisband-Priifsignale 020-2774-XX
Signalquellen fiir Serie VM, PC-Bitmapdateien fiir Grafiktests 020-2775-XX
Signalquellen fiir Serie VM, SD & HD-Streams nach H.264 020-2776-XX
Wartungshandbuch fiir Digital-Phosphor-Oszilloskope der Serie DPO70000 071-1174-XX
Transportkoffer 016-1942-00
Tastkopfkalibrierungs-, Kompensations- und Deskew-Adapter 067-0405-XX
Vorrichtung fiir den Strom-Deskew 067-1478-00
Video-Anzeigeklemme 013-0278-XX
Passiver Tastkopf P5050 500 MHz 10x P5050
GPIB-Kabel (1 m) 012-0991-01
GPIB-Kabel (2 m) 012-0991-00
Centronics-Kabel (Drucker) 012-1214-00

1 Auf unserer Website unter www.tektronix.com finden Sie eine aktuelle Liste mit Zubehér, Aktualisierungen und Optionen, einschlieRlich der fiir
Ihr Videomesssystem der Serie VM verfiigbaren Serviceoptionen.
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Betriebsvoraussetzungen

1. Stellen Sie das Geréat auf einem 17.96 in
Rollwagen oder einen Labortisch, (456.00 mmy)
und beachten Sie die erforderlichen
Abstande:

®  QOberseite, Riickseite, Vorderseite am
und rechte Seite 0 mm

0
o

B Linke Seite: 76 mm 10.90 in

(277.00 mmy)

om Blfo

Omo o

= Unten: 19 mm oder 0 mm
mindestens bei FuBaufstellung,
Stand heruntergeklappt

OO0
OO0t

2. Stellen Sie vor dem Betrieb sicher, dass
die Umgebungstemperatur zwischen ‘ o ‘ [ ©) ©
+5°C und +45°C liegt. - -

c VORSICHT. Halten Sie die Unterseite und die Seiten des Geréts frei, um die erforderliche Kiihlung zu gewahrleisten.

Einschalten des Gerats

Stromversorgung - Voraussetzungen

Stromspannung und -frequenz Stromverbrauch
100-240 V5 £10%, 47-63 Hz oder 115 Vi £10%, 550 W, max.
360-440 Hz
o © ° ~
> oo oo o
! S O's 8l
.E?"ib d ° 2%,
@ 0%, - Olss

5
&
—
P
[((C
«I‘:}
=00
O=ot0
O=0t0

- o =
W C Bjleed| ®
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Ausschalten des Gerats

0
O

on pgfo

Qmo mo

Abziehen des Netzkabels

© e e

@
[ =
B

@&
@ o@o D -L:I
=)ol o
ﬁ . . (@)
— = g T

Verbindung zu einem Netzwerk herstellen

Das Anschliefen des Gerats an ein ‘
Netzwerk ermdglicht u. a. das Drucken, das
gemeinsame Nutzen von Dateien und den
Zugriff auf das Internet. Wenden Sie sich an
Ihren Netzwerkadministrator, und verwenden
Sie die Windows-Standardprogramme, um
das Gerat fiir Ihr Netzwerk zu konfigurieren.
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Umgang mit dem Gerat

Umgang mit dem Gerat
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Umgang mit dem Gerat

Seitenplatten und Riickplatte

1. USB-Schnittstellen @ @
1T ‘Dﬁfﬂ"ﬂ‘ﬁ’?

2. Videoanschluss zum AnschlieRen eines
Monitors fir die Anzeige nebeneinander

3. Mic-Stecker fiir das Mikrofon

4. Line-Out-Stecker flir den Lautsprecher
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5. Scope Only XGA Out-Videoanschluss
zum AnschlieBen eines Monitors
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6. Druckerverbindung

7. Line-In-Stecker

8. RJ-45-LAN-Stecker fiir den Anschluss
an ein Netzwerk

9. Parallele Schnittstelle (Centronics)

10. Serielle Schnittstelle COM 1 ©

L

11. PS-2-Anschluss fir die Maus
12. PS-2-Anschluss fiir die Tastatur

13. TekLink-Stecker flir zukUnftige
Anwendungen

14. Wechselfestplatten-Laufwerk

15. GPIB-Schnittstelle fiir den Anschluss an
den Controller

16. Zusatzlicher Ausgang

17. Ausgang fir Kanal 3

18. Externer Referenzeingang
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Umgang mit dem Gerat

Voraussetzungen fur Eingangsverbindungen - Optionen SD/HD

Verwenden Sie nur 75 Q-Koaxialkabel, um das gepriifte Videobauteil an das Instrument anzuschlieRen.

Installieren Sie die beiliegenden Direkter Anschluss an Eingangskanal-BNC
75-Ohm-Abschlisse mit Hilfe des VM5000

der BNC-T-Verbinder zwischen 75-Ohm-Prazisionsabschluss-

den Koaxialkabeln und den 75-0hm-Koaxialkabel l > widerstand (011-0102-03)
Gerateingangskanalen. Um genaue -

Frequenzgangmessungen zu erreichen, ist l <

es unerlasslich, die T-Verbinder direkt an die _:jj:ﬂ > “

Eingangskanal-BNCs anzuschliefen.

BNC-T-Verbinder
(103-0030-00)

Voraussetzungen fiir Eingangsverbindungen - Option VGA

Die bevorzugte Methode zum AnschlieRen
des gepriften Videobauteils an das
Instrument besteht in der Verwendung
der RGBHV-Messschnittstelleneinheit.

Die Messschnittstelleneinheit enthalt

eine impedanzangepasste Schaltung und
gewahrleistet so genaue Messergebnisse.
Fir einige Messungen wird ein
Niederfrequenzpfad verwendet, fiir andere
Messungen hingegen ein Breitbandpfad.
Die Serie VM wahlt den zu verwendenden
Pfad dber eine RS-232-Verbindung mit der
Messschnittstelleneinheit aus.

11 1 MM

Sie kdnnen das gepriifte Videobauteil VGA-Anschluss an 5X-Kabel

auch mit Hilfe des mitgelieferten g
VGA-Anschluss-zu-5X-Kabels an das
System der Serie VM anschlieflen. Wenn
Sie sich fir dieses Verfahren entscheiden,
wird das Kabel mit Hilfe der gelieferten
Prazisionsabschllisse an das System der
Serie VM angeschlossen. Je nachdem,
welche Messungen ausgefiihrt werden
sollen, miissen Sie die Abschlisse wahrend
der Messungen méglicherweise manuell
wechseln.
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Umgang mit dem Gerat

Verbinden von Eingangssignalen

Setup 1 fiir Option SD/HD

Die Setups 1A und 1B werden zum Uberpriifen analoger Videokomponentensignale (Y/G, Pb/B, Pr/R) fiir dreiadrige Kabel
mit dem Composite-Sync-Signal auf Y/G bevorzugt. Sie leiten das Triggersignal mit Hilfe des Sync-Pickoff-Zubehdrs

aus dem Y/G-Signal auf CH1 ab. Die Triggerquelle ist auf Kanal 4 festgelegt. Diese Konfiguration erméglicht genauere
rauscharme Messungen (unter -60 dB bei einer Bandbreite von 30 MHz) als Setup 2.

Durch diese Verbindungsart wird wahrend der Triggerung auf CH4 eine genauere Rauschmessung auf CH1 erméglicht,
ohne dass eine zusatzliche Verkabelung zwischen CH1 und CH4 erforderlich ware. Die zuséatzliche Verkabelung kann den
Frequenzgang beeintrachtigen und zu Mehrfachbursts bei Messungen fiihren.

Um den besten Frequenzgang und Mehrfachburst-Messungen zu erreichen, muss der 75 Q-Abschluss so nah wie mdglich
an den Eingangsanschluss angeschlossen sein, wie in der Setup-Abbildung dargestellt.

Es gibt zwei Mdglichkeiten, um das Sync-Pickoff an das System der Serie VM anzuschliefen. Bei der ersten Mdglichkeit
wird das Sync-Pickoff direkt an den Eingang angeschlossen, bei der zweiten Méglichkeit erfolgt dies mit Hilfe eines
T-Verbinders, der an einen 75 Q-Abschluss angeschlossen wird. Die verwendete Methode richtet sich nach der von lhnen
eingesetzten Sync-Pickoff-Version.

Setup 1A - Dreiadriges Analogvideokabel und mit Composite-Sync for Sync-Pickoff 012-1680-01. Bei
Verwendung eines 012-1680-01-Sync-Pickoffs (mit einem internen 75 Q-Abschluss) schlieBen Sie das Sync-Pickoff
entsprechend der folgenden Abbildung direkt an den CH1-Eingang des Systems der Serie VM an (mit einem
TPA-BNC-Adapter flir VM6000 und Instrumente der Serie DPO7000). Bei Verwendung eines 012-1680-00-Sync-Pickoffs
(erfordert einen externen 75 Q-Abschluss) gehen Sie wie in der Abbildung in Setup 1B vor.

AnschlieRen an ein Instrument der Serie VM6000 / DPO7000.

[ = o ]

coodoOboQ

O
O

BNC-T-Verbinder o
Signalquelle
(Tektronix MTX100)
o ooo Set-TOp'BOX
8 @6@ Modulator
O YIG PyB PJR
old [ | P P @

Sync-Pickoff
(012-1680-01)

Y/G Pp/B PR
\. dJ

[DJD = BNC-T-Verbinder @ =75 Q-Abschlusswiderstand

2091-006
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Umgang mit dem Gerat

AnschlieRen an ein Instrument der Serie VM5000 / TDS5000.

Signalquelle
(Tektronix MTX100)

o]
o
0

0000
el

ol C—— ]

Modulator

BNC-T-Verbinder
Set-Top-Box

YIG PyB PR

» @ @ L]

Sync-Pickoff
(012-1680-01)

\

V)

YIG Py/B PR

J

[DJD = BNC-T-Verbinder @ =75 Q-Abschlusswiderstand

2091021

Setup 1B - Dreiadriges Analogvideokabel mit Composite-Sync fiir Sync-Pickoff 012-1680-00. Bei
Verwendung eines 012-1680-00-Sync-Pickoffs (die Teilenummer befindet sich auf dem Etikett des groferen Moduls)
schlielen Sie das Sync-Pickoff entsprechend der folgenden Abbildung an den CH1-Eingang des Systems der Serie VM an.
Bei Verwendung eines 012-1680-01-Sync-Pickoffs gehen Sie entsprechend der Abbildung in Setup 1A vor.

AnschlieRen an ein Instrument der Serie VM6000 / DPO7000.

Signalquelle
(Tektronix MTX100)

o 00O
O <=
o (10])

ol C—— ]

Modulator

= o ]

BNC-T-Verbinder

cocodobop

10

Set-Top-Box

CH3
YIG PyB  PJR
P P @

[Dﬂ = BNC-T-Verbinder @ =75 Q-Abschlusswiderstand

Sync-Pickoff

Y/G Pp/B PR
VR

2001013
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Umgang mit dem Gerat

AnschlieRen an ein Instrument der Serie VM5000 / TDS5000.

Signalquelle
(Tektronix MTX100)
8 oo Set-Top-Box S
S
o} @ O 8 Modulator
O "= YIG PyB PJR ]
oll 1 [] TP Py

Sync-
Sync-Pickoff Pickoff

(012-1680-01)

Y/G Py/B PR
\. 42 J

nzﬂ = BNC-T-Verbinder @ =75 0-Abschlusswiderstand

2091022

Die folgende Abbildung veranschaulicht, wie das 012-1680-00-Sync-Pickoff an den CH1-Eingang angeschlossen wird.

Anschluss an CH1-Eingang

Synchronisations-Pickoff BNC-Stecker an BNC-Stecker |  75-0hm-Prézisionsabschlusswiderstand
(012-1680-00) (103-0029-00) X (011-0102-03)
] o
o e[l e

BNC-Buchse an BNC-Buchse BNC-T-Verbinder
(103-0028-00) (103-0030-00)

Anschluss an CH4 fiir Trigger

HINWEIS. Stellen Sie sicher, dass der Triggerkanal auf Kanal 4 festgelegt ist (Standardeinstellung). Wenn die
Triggereinstellung (,Configuration > Operation”) (Konfiguration > Betrieb) nicht auf CH4 festgelegt ist, werden
Signalwarnmeldungen angezeigt, und es kénnen keine Messungen ausgefiihrt werden.
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Umgang mit dem Gerat

12

Setup 2 fiir Option SD/HD - Dreiadriges Analogvideokabel mit Composite-Sync

Dieses Setup kann verwendet werden, um Analogvideosignale (Y/G, Pb/B, Pr/R) flir dreiadrige Kabel mit dem
Composite-Sync-Signal auf Y/G zu priifen. Legen Sie die Triggerung flir das Instrument auf CH1 fest (die
Triggerstandardeinstellung ist CH4). Dieses Setup ist einfacher als die anderen in diesem Kapitel erwahnten, es beschréankt
jedoch die Rauschmessung auf Y/G bis -65 dB (30 MHz Rauschbandbreite).

AnschlieRen an ein Instrument der Serie VM6000 / DPO7000.

[ = = 1

cooaAadODOO

O 8 oo

Signalquelle O °2|To
(Tektronix MTX100) s Olso
o o o o

ofjo © O

o ocoo Set-Top-Box O 00O

3 @C(;D Modulator

0 - i

O V= e A PR 3
olm 1 M — <P ® @ cH1 Jerz JeHs Jera  eow

YIG PyB P/R

J

mD = BNC-T-Verbinder g = 75 Q-Abschlusswiderstand

AnschlieRen an ein Instrument der Serie VM5000 / TDS5000.

Signalquelle
(Tektronix MTX100)

© ooo Set-Top-Box

QD Modulator .
o VG PyB PR ©!

oll 1 [ Sy ¢ ¢ Y CH1

cH2 [cHa JcHa ]

2091-028

YIG PyB P/R

J

H]ﬂ = BNC-T-Verbinder g =75 Q-Abschlusswiderstand
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Umgang mit dem Gerat

Setup 3 fiir Option SD/HD - Dreiadriges Analogvideokabel mit separater Composite-Sync

Verwenden Sie dieses Setup zum Priifen analoger Videokomponentensignale (Y/G, Pb/B, Pr/R) fir vieradrige Kabel
mit dem Composite-Sync-Signal an einem separaten Ausgang. Fir CH4 kénnen Sie das Signal ohne einen Abschluss
anschlieen, oder Sie kdnnen einen 75-Ohm-Abschluss verwenden, der weniger prézise ist als die mit dem Gerét gelieferten

75-Ohm-Abschliisse.

AnschlieRen an ein Instrument der Serie VM6000 / DPO7000.

[ = o= |
cooadbop
[e) oo
REE.
Signalquelle O O ©
(Tektronix MTX100) Gepriftes oo
Videobauteil (DUT) offo © ©
o o0 O O O

8 @%bg Modulator 0
= = o)l (6

YIG PyB PJR Sync

ol 1] m (P OO0 Sl o ) I
YIG PyB
Plr/R Synchronisationj
[DJD = BNC-T-Verbinder @ =75 Q-Abschlusswiderstand

AnschlieRen an ein Instrument der Serie VM5000 / TDS5000.

Signalquelle
(TektroniX MTX1 00) Gepruftes
Videobauteil (DUT)
O 00O
Q
O (1) | Moduator .
O = /G PyB PJR Synch o © |°_,
— = cH1 | cH2 JcHs
1
o0 CP Y9 CH4
Y/G PyB
Synchronisation
P/R
y; D)
[DJD = BNC-T-Verbinder @ =75 Q-Abschlusswiderstand

HINWEIS. Stellen Sie sicher, dass der Triggerkanal auf Kanal 4 festgelegt ist (Standardtriggerkanal). Wenn die
Triggereinstellung nicht auf CH4 (,Configuration > Operation®) (Konfiguration > Operation) festgelegt ist, werden
Signalwarnmeldungen angezeigt, und es kénnen keine Messungen ausgefiihrt werden.

Schnellstart-Benutzerhandbuch fiir Videomesssysteme der Serie VM
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Umgang mit dem Gerat

Setup 1 fiir Option VGA - RGBHV-Messschnittstelleneinheit

Dies ist das bevorzugte Setup zum Priifen von PCs und Videogeraten. Verwenden Sie die RGBHV-Messschnittstelleneinheit,
um die PC-Videokarte an das System der Serie VM anzuschlieRen. Bei Verwendung der RGBHV-Messschnittstelleneinheit
werden die genauesten Messergebnisse erzielt.

AnschlieRen an ein Instrument der Serie VM6000 / DPO7000.

Hinterer RS 232 C-Anschluss —— ]
cooddODoQ
PC =oloo
— Messschnittstelleneinheit
I e S—
I Ty
:m
I T
@) VGA-Anschluss
an 5X-Kabel
’O RS$2 che O
X
012-1685-00
RGBHY
Messschnittstelleneinheit "
+ e 0@

2091-009
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Umgang mit dem Gerat

AnschlieRen an ein Instrument der Serie VM5000 / TDS5000.
Hinterer RS 232 C-Anschluss

PC
— Messschnittstelleneinheit
[T T
i
:m
i
@) VGA-Anschluss )
an 5X-Kabel
’O RS$2 A* CH1 cz\/cs CHe O
X
012-1685-00
RGBHV
Messschnittstelleneinheit ”

So schlieRen Sie die RGBHV-Messschnittstelleneinheit an:

1. SchlieBen Sie das geprifte Bauteil PC
mit Hilfe eines der mit dem —
System der Serie VM gelieferten
VGA-zu-BNC-Adapterkabel © ©
an den Eingang der
RGBHV-Messschnittstelleneinheit
an.

RGBHV MIU

<|T|A|w |®
[l
I

lo—aT
L
O VGA-Anschluss e > 9

an 5X-Kabel
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Umgang mit dem Gerat

2. Schlielen Sie die Ausgange [ r—w—
(AUX, CH1-CH4) der cooaoboo
RGBHV-Messschnittstelleneinheit
an die entsprechenden Ausgange RGBHV MIU
des Systems der Serie VM (d. h. © . 9
CH1-Ausgang an CH1-Eingang) an. -|!]

| T —
SRS

\.

\, CH4 J 2001011
Instrument der Serie VM6000 / DPO7000

RGBHV MIU

[€)
o)

A

Serie VM5000 / TDS5000
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3. Verbinden Sie die RGBHV-
Messschnittstelleneinheit und den
COM1-Anschluss am System der Serie
VM mit dem RS-232-Kabel.

4. Uberpriifen Sie, ob auf der Registerkarte
,Configuration > Operations*
(Konfiguration > Operationen)
das Kontrollkdstchen Use MIU
(Messschnittstelleneinheit verwenden)
aktiviert ist.

Umgang mit dem Gerat

RS232 COM1
RGBHV MIU

A

2091012

%Elle Corfiguration  Results Utilities  Help

Configuration
(Format [Measurements [ Operation [Warnings | Reference & Limits

Setup AndiOr Run Run Mode Line Select Auto Scale

RGBHY MIU Sync Polarity Report Mode

=
Use MIU Auto Detect I pture Restore Default
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Umgang mit dem Gerat

18

Setup 2 fiir Option VGA - VGA-Anschluss an 5X-Kabel

Verwenden Sie dieses Setup zum Prifen von PCs und Videogeréaten, wenn sich die RGBHV-Messschnittstelleneinheit nicht
dazu eignet. Um sicherzustellen, dass die Messungen genau sind, schlieBen Sie das System der Serie VM an die T-Verbinder
und Prazisionsanschliisse an CH1-CH4 an. Sie missen den 75 Q-Abschluss an CH1-CH3 (verwendet fir GBR) und den
2,21 kQ- sowie den 301 Q-Abschluss an CH4 verwenden (verwendet fiir H Sync- und V Sync-Messungen). Diese Methode
erfordert, dass die Signal- und Abschlussanschliisse an CH4 fiir bestimmte horizontale und vertikale Messungen geandert
werden. Das System der Serie VM zeigt ein Dialogfeld an, in dem Sie dazu aufgefordert werden, ggf. diese Anderungen
vorzunehmen (die RGBHV-Messschnittstelleneinheit fihrt diese Anschluss- und Abschlussanderungen intern durch).

So schlielen Sie das geprifte Bauteil mit Hilfe eines VGA-zu-5x-Kabels an das System der Serie VM an:

1.

Installieren Sie die beiliegenden
75-Ohm-Abschliisse mit Hilfe

der BNC-T-Verbinder zwischen

den BNC-Kabeln und den
Gerateingangskanalen 1 bis 3.

Um prazise Messungen zu erreichen,
ist es unerlasslich, die T-Verbinder
direkt an die Eingangskanal-BNCs
anzuschlieen.

Bei der Ausfiihrung von H Sync-,

V Sync- oder V Timing-Messungen sind
2,21-Kiloohm- und 301-Ohm-Abschlisse
erforderlich. Dazu werden die

als Standardzubehdr gelieferten
BNC-to-Binding-Post-Adapter und
-Widerstande bendtigt. SchlieRen Sie
jeden Widerstand an einen Adapter an,
wie in der Abbildung dargestellt.

Direkter Anschluss an Eingangskanal-BNC
des VM5000

VGA-Anschiuss an 5X-Kabel l 75-Ohm-Prézisionsabschlusswiderstand
‘ (011-0102-03)

G[DILE

BNC-T-Verbinder
(103-0030-00)

>
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3. Legen Sie die VGA-Signale
entsprechend der Abbildung an
das System der Serie VM an. Schlieflen
Sie zun&chst das H Sync-Signal mit
Hilfe des 2,21 kQ-Abschlusses an.
Das System der Serie VM fordert Sie
ggf. auf, den 301 Q-Abschluss zu
verwenden.

Schnellstart-Benutzerhandbuch fiir Videomesssysteme der Serie VM

VGA-Anschluss
an 5X-Kabel

.

[ 0 = ]

coodgoboQ

Og oo
jan

O Ao
OC)C)

o
o dlg o
s

SRR

G| B] R| H| |V

2091010

VGA-Anschluss
an 5X-Kabel
N
L]
\,

Instrument der Serie VM6000 / DPO7000

0

o]

Instrument der Serie VM5000 / TDS5000
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Umgang mit dem Gerat

20

In einer Popupwarnung werden Sie

beim Ausflihren einer H Sync-Messung
aufgefordert, den Signalabschluss auf CH4
zu andern.

In der folgenden Tabelle ist dargestellt, welches Signal vom gepruften Bauteil an welchen Eingang des Systems der Serie
VM angeschlossen und welcher Abschluss fiir die einzelnen Signale verwendet wird.

VGA-Signal Eingang des Systems der Serie VM Abschluss

Griin CH1 75 Ohm

Blau CH2 75 Ohm

Rot CH3 75 Ohm

H Sync CH41 2,21 Kiloohm und 301 Ohm
V Sync AUX Kein

1 Das V Sync-Signal ist bei der Durchfiihrung von V Timing- und V Sync-Messungen an diesen Kanal angeschlossen. Das System der Serie VM
fordert Sie ggf. auf, diesen Anschluss zu verwenden.
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Umgang mit dem Gerat

Signalpfadkompensation

Zum Optimieren der Messgenauigkeit lesen Sie bitte in der Online-Hilfe zum Oszilloskop nach, und fiihren Sie die folgenden
Verfahren fiir die Signalpfadkompensation des Instruments aus: Verwenden Sie dieses Verfahren, wenn sich die Temperatur
seit der letzten Signalpfadkompensation um mehr als 5° C geandert hat. Fiihren Sie die Signalpfadkompensation

einmal wochentlich durch. Wenn Sie dies unterlassen, kann das Instrument bei diesen Einstellungen fiir Volt/Skalenteil
moglicherweise nicht die garantierte Leistung erreichen.

Sync-Pickoff-Kompensation — Serien VM6000 und DPO7000, nur Optionen
SD/HD

So kompensieren Sie das Sync-Pickoff ordnungsgeméaR:

1. Verbinden Sie das kleine Gehause
des Sync-Pickoff (gekennzeichnet
mit “Connect to Trigger Channel” /
Anschlieffen an Triggerkanal) mit CH4.
Lassen Sie das groBe Gehause vom
Instrument getrennt.

2. Schlielen Sie den Sync-Pickoff-
BNC-Anschluss an einen BNC-zu-
Minigrabber-Anschluss an (Pomona
Electronics-Modellnummer 3789)

3. SchlieRen Sie die Minigrabber an den
PROBE COMP-Anschluss an.

2091-015
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Umgang mit dem Gerat

4. Driicken Sie AUTOSET (AUTO-SETUP). @

Default
Autoset Setup

& %

@ Push-E8 | Horizontal
Position

Multiview
Zoom

Del
2091016

5. Uberpriifen Sie die Form des @
angezeigten Signals, um zu bestimmen, I l r_ I | | I
ob der Sync-Pickoff ordnungsgeman

kompensiert ist. Ordnungsgemaf Unterkompensiert Uberkompensiert
kompensiert

6. Stellen Sie den Sync-Pickoff ggf. ein.
Wiederholen Sie diesen Vorgang so oft
wie nétig.

Sync-Pickoff-Kompensation — Serien VM5000 und TDS5000, nur Optionen
SD/HD

So kompensieren Sie das Sync-Pickoff ordnungsgemaR:

1. SchlieRen Sie das Sync-Pickoff-Kabel ( )
an CH1 und CH4 an. Verbinden Sie

2 0
das kleine Gehause des Sync-Pickoff g5=5
(gekennzeichnet mit “Connect to Trigger %g% i
Channel” / AnschlieBen an Triggerkanal) S‘o S
mit CH4. sl e

©
5
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Umgang mit dem Gerat

2. Schlielen Sie den Sync-Pickoff-

OD‘OOOOOO
BNC-Anschluss an einen BNC-zu- SIEIIE IR

Minigrabber-Anschluss an (Pomona
Electronics-Modellnummer 3789)

3. SchlieRen Sie die Minigrabber an den
PROBE COMP-Anschluss an.

4. Wahlen Sie CH1 und CH4. Driicken Sie
FastAcq (Schnellerfassung). Driicken

Sie AUTOSET (AUTO-SETUP).

Die Signale beider Kanale (CH1 (o) | (e =
und CH4) werden angezeigt. Es RO o
ist normal, dass das Signal eine @

Schrage aufweist. Dies ist auf die

75 Q-Terminierungslast des Sync-Pickoff
am PROBE COMP-Ausgangssignal
zurlickzufiihren.

5. Uberpriifen Sie die Form des
angezeigten Signals, um zu bestimmen,
ob der Sync-Pickoff ordnungsgeman
kompensiert ist.

LT
L

I

2091026

%

2091-024

Unterkompensiert
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Umgang mit dem Gerat

I .

2091-026

Uberkompensiert

6. Stellen Sie den Sync-Pickoff ggf. ein.
Wiederholen Sie diesen Vorgang so oft
wie notig.
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Umgang mit dem Geréat

Informationen zum Matrixtestsignal

Das Matrixtestsignal befindet sich auf den diesem Produkt beigefligten Disketten mit Signalquellen. Es gibt ein
Matrixsignal fiir die Optionen SD und HD und ein Matrixsignal fiir die Option VGA. Das Matrixsignal enthalt alle
Analogvideosignalanforderungen in verschiedenen Zeilennummern innerhalb eines Priifmusterfeldes. Durch die Verwendung
eines einzigen Priifmusters miissen die Priifsignale wahrend der verschiedenen Messungen nicht geandert werden. Sie
mussen nur die Anzahl der Zeilennummern angeben, fiir die die Messungen ausgeflihrt werden sollen. Verwenden Sie die
Setup-Datei (.vmset), die dem Format des von Ihnen verwendeten Matrixprifsignals entspricht. Dadurch werden fiir jeden
Messtyp die als Standardeinstellung geeigneten Zeilennummern zur Verfiigung gestellt. Eine vollstandige Beschreibung der
Dateien auf den Signalquellendisketten finden Sie im Benutzerhandbuch fiir die Videomesssysteme der Serie VM.
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Matrixsignal fiir Option SD/HD

Matrixsignal fiir Elemente der Option SD/HD

Signalname Format Signalname Format Signalname Format

1. Farbbalken Alle 7. YPbPr-Ablenkzeit YPbPr 13. Gliltige Rampe ~ Alle

2. RGB-Impulsbalken RGB 8. YPDLPr- YPbPr 14. YPbPr- YPbPr
Ablenkfrequenz Flachrampe

3. RGB- RGB 9. YPDbPr- YPbPr 15. RGB- RGB

Frequenzablenkung Mehrfachburst Flachrampe

4. RGB-Zeitablenkung RGB 10. YPbPr- YPbPr 16. Flaches Alle
Mehrfachburst Halbbild 7,5 %

5. RGB- YPbPr 11. RGB- RGB 17. Flaches Alle

Mehrfachburst Ubersprechen Halbbild 50 %

6. YPbPr- YPbPr 12, YPbPr- YPbPr 18. Flaches Alle

Impulsbalken Ubersprechen Halbbild 100 %

Schnellstart-Benutzerhandbuch fir Videomesssysteme der Serie VM 25



Umgang mit dem Gerat

26

Matrixsignal fiir Option VGA

Matrixsignal der Elemente fiir Option VGA

Signalname

Signalname

1. Halfte weill und Halfte schwarz

5. Schwarz/weil/schwarz

2. Neun Farbbalken

6. Vollweil

3. 32 Stufen

7. Rampe

4. Alternierend weils und schwarz

8. Halfte weil} und Halfte schwarz
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Umgang mit dem Gerat

Starten der Systemsoftware der Serie VM

1. Schalten Sie das Geraét ein. ———
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2. Wahlen Sie Analyze > VM HD and _
SD Video (Analysieren > VM HD- und Analyze | Ltities | Help |
SD-Video) oder VM VGA Video (VM —
VGA-Video). Restore Application

il HD andd S0 Wideo
W WA Yiden

Option SD/HD

Analyze | Lilities | Help |

Restore Application
Wil HD and S0 Wideo
W WA Video

Option VGA
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Umgang mit dem Gerat

Das Instrument zeigt das Signal nur in
der oberen Halfte der Anzeige an und
offnet die Anwendung des Systems
der Serie VM in der unteren Hélfte der
Anzeige.

# Fio Cconfguration Fesults Ules Help

Cenfiguration

Fommat | Measuramants | Oporation [Wamings | Aaforance & Limiss | Picture & Vecar -
Format Coler Space
o

Configurs

User Defined Formst

g | Display | Curs;

«» 100mviaiv Q™ /16 100ps 200MS/s 5.0nsipt
«©» 100mvidiv Trig Diy: 10 events Ru Sample
T 100mvidiv Ao S22y 145 acqs RL:200k
«@» 1.02vidiv | october 10, 2006

& File Configuration Resulls Ulliies Help
Configuration
Format | Measurements | Operation | Wamnings | Reference & Limits
Resolution Refresh Rate Timing

Configure

User Defined Format

Option VGA
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Die Benutzeroberflache der Serie VM-Software

1.

Menileiste: Wahlt die in der
Anwendungsanzeige anzuzeigenden
Bedienelemente fiir Einstellungen und
Informationen zu den Ergebnissen an.

Anwendungsanzeige: Zeigt die
Bedienelemente fiir die Konfiguration
und die Messergebnisse an.

Schaltflache Run (Ausflihren): Initiiert
das Einrichten, startet die Messungen
und zeigt die Ergebnisse an.

Schaltflache ,Stop“ (Anhalten): Halt
Messungen an.

Schaltflache ,Picture” (Bild): Zeigt das
Signal als Bild an.

Schaltflache ,Vectorscope® (Vektorskop):
Zeigt das Signal im Vektorskop-Format
an. (Nur Option SD/HD)

Schaltflache ,Hide" (Ausblenden):
Stellt die Hauptanzeige als
Gesamtbildschirm wieder her und
verbirgt das Anwendungsfenster hinter
der Hauptanzeige.

Wahlen Sie Hide (Ausblenden) aus, um
(zum Anzeigen von Berichten) auf den
Windows-Desktop zuzugreifen. Wahlen
Sie in der Hauptanzeige File > Minimize
(Datei > Minimieren >) aus, und klicken
Sie dann erneut auf die Schaltflache
Hide (Ausblenden).

Umgang mit dem Gerat

User Defined Farmat

Hid=

Schnellstart-Benutzerhandbuch fiir Videomesssysteme der Serie VM

29



Umgang mit dem Gerat

30

8. So stellen Sie eine ausgeblendete

Anwendung wieder her: Wahlen Sie
den Befehl Restore Application
(Anwendung wiederherstellen) im
MenU Analyze (Analysieren) (VM60000
/ DPQO7000), oder klicken Sie auf
Schaltflache App (Anw.) (VM5000 /
TDS5000).

. Schaltflache Exit (Beenden): Beendet

die Anwendung der Serie VM und
setzt das Instrument zurlick auf die
standardmaRige Hauptanzeige.

e | Ltiities | Help |

Whi

Whi

HD and =0 Yideo

WEA Wideo

VM6000 / DPO7000

App

VM5000 / TDS5000

Exit
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Umgang mit dem Gerat

Verfahren zum Ausfiihren von Messungen

1. Legen Sie die Formatparameter fiir das Eingangssignal mit Hilfe von Configuration > Format (Konfiguration >
Format) fest.

2. Wahlen Sie eine oder mehrere durchzufiinrende Messungen mit Hilfe vonConfiguration > Measurements
(Konfiguration > Messungen) aus.

3. Legen Sie die Ausfilhrungsoptionen fir Messungen mit Hilfe von Configuration > Operation (Konfiguration > Betrieb)
fest.

4. Klicken Sie auf die Schaltflache ,Run (Ausfiihren), um die Messungen auszufiihren und anzuzeigen.

5. Speichern Sie die Messergebnisse mit Hilfe von Utilities > Generate Report (Dienstprogramme > Bericht generieren)

Konfigurieren des Priiflings — Option VGA

Um die Messungen fiir das geprifte Bauteil durchzufiihren, missen Sie ein entsprechendes Videosignal an das System der
Serie VM anlegen. Dies erreichen Sie durch das Anzeigen einer Bitmapdatei auf dem PC, iber den das gepriifte Bauteil
betrieben wird. Beim Durchfiihren mehrerer Messungen stellt das Matrixsignal die bevorzugte Bitmapdatei dar. Wenn Sie
nur eine Messung ausfiihren, kann ein Prifmuster mit vollstandigem Halbbild anstelle des Matrixsignals verwendet werden.
Alle erforderlichen Bitmaps fir Matrixsignal und Priifmuster mit vollstandigem Halbbild zum Uberpriifen der Einhaltung des
VESA-Uberprifungsverfahrens — Auswertung der Anzeigegrafik-Untersysteme (Version 1, Rev. 1) finden Sie auf der
CD-ROM PC-Bitmapgrafik-Priifsignaldateien.

1. Legen Sie die Auflésung und die
Aktualisierungsrate des Priflings auf die
erforderlichen Werte fest.

2. Zeigen Sie auf dem PC mit dem
Prifling den Inhalt der CD-ROM
PC-Bitmapgrafik-Priifsignaldateien an.

3. Zeigen Sie entweder den Inhalt des
Ordners ,Matrix“ oder des Ordners ,Full
Field“ (Vollstdndiges Halbbild) an.

= Offnen Sie den Ordner ,Matrix*, wenn
mehrere Messungen ausgefiihrt
werden sollen.

= Wenn nur eine Messung ausgefiihrt
werden soll, 6ffnen Sie den
Ordner ,Full Field“ (Vollstandiges
Halbbild), und wéhlen Sie mit
Hilfe der folgenden Tabelle das
entsprechende Priifmuster aus.
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Entsprechende Messungen fiir die jeweiligen Priifmuster mit vollstandigem Halbbild

Messung Jeweilige(s) Priifmuster
Konflikt zwischen Kanélen 32-Stufen-Treppe

Versatz zwischen Kanélen Alternierend Wei und Schwarz
Farbbalken Neun Farbbalken

H Sync Beliebiges Muster

H Sync-Jitter Beliebiges Muster

H Timing Schwarz/weilt/schwarz
Linearitat Treppe

Luminanzstufen Alternierend WeiR und Schwarz
Rauschinjektions- verhéltnis Vollweily

Video-Transiente Alternierend Weil} und Schwarz
V Sync Beliebiges Muster

V Timing Halfte weifl und Halfte schwarz

Unabhangig davon, ob Sie ein einzelnes Prifmuster auswahlen oder mehrere Messungen aufiihren, miissen Sie die
Bitmapdatei auswahlen, die zum Generieren des Videoprifsignals angezeigt werden soll. Die ausgewahlte Datei ist
abhangig vom zu priifenden Format. Angenommen, Sie mdchten ein Format mit einer Aufldsung von 1280 x 1024 priifen (die
Aktualisierungsrate wird bei der Auswahl von Bitmapdateien nicht beriicksichtigt). Suchen Sie im entsprechenden Ordner
nach einen Dateinamen, der dem Format der durchzufiihrenden Prifung entspricht. Wenn die Linearitat geprift werden soll,
missen Sie entweder ein Treppenpriifmuster mit vollstandigem Halbbild auswahlen oder das Matrixpriifmuster verwenden.
Im Ordner ,Staircase” (Treppe) missen Sie nach einer Datei mit dem Namen STEP1280X1024.bmp suchen. Suchen Sie im
Ordner ,Matrix"“ (Matrix) nach einer Datei mit dem Namen MAT1280X1024.bmp.

4. Wahlen Sie die Bitmapdatei aus, die den

Imige Cors iarws Seectors

& e g

|= =

Anforderungen entspricht, und 6ffnen beoe Cmwwm e
Sie die Datei mit einem Programm wie

Paint Shop Pro.

Wenn Sie den Priifling fir eine zweite
Anzeige einrichten, kénnen Sie den
Hintergrund der zweiten Anzeige auf die
Bitmapdatei festlegen, anstatt die Datei
in einem Bitmap-Editor zu &ffnen.

XL kb

l%)b;'eisl%\\\-nn*v#_ o
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Umgang mit dem Gerat

5. Wahlen Sie im Meni ,View" (Ansicht)
die Option View > Full Screen Preview
(Ansicht > Vollbildvorschau) aus.

Die BMP-Datei wird im Vollbildmodus
ohne Réander angezeigt.

6. Trennen Sie den Ausgang des gepriiften
Bauteils vom Monitor, und schlieBen
Sie den Ausgang des Priflings an das
System der Serie VM an.

Festlegen des Eingangssignalformats — Optionen SD/HD

1. Wahlen Sie Configuration > Format Configuration  Results
(Konfiguration > Format) aus. Format
Measurements
COperation
Warnings

Reference & Limits
Ficture & Vector

Die Anwendung zeigt die Ansicht Gonfiguration
Formatu an |"'Fm|-|al Measuremants | Operation [ Wamings 'Reference & Limits | Pictura & Vector |

Farmat Color Space
HE Form
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2. Wahlen Sie das entsprechende

Videoformat fiir das gemessene Signal
aus.

Wabhlen Sie den entsprechenden
Farbraum fir das gemessene Signal
aus.

Format

50 Formats HD Formats
4801/ 60

#® Auto Detect i

Color Space

@ YPOPr

Erstellen eines benutzerdefinierten Formats

Wenn Sie ein Format priifen mochten, das auf der Registerkarte Format nicht aufgelistet ist, kdnnen Sie ein
benutzerdefiniertes Format erstellen.

1.

Wahlen Sie Configuration > Format
(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht Format
an.

Wahlen Sie Add (Hinzufligen) aus, um
ein neues Format hinzuzufiigen. Hiermit
wird das Fenster Create User Defined
Format (Benutzerdefiniertes Format
erstellen) angezeigt.

Configuration Results

Format
Measurements
Operation
Warnings
Reference & Limits

Ficture & Vector

Configuration
|"'Fnr|-|al Measuremants | Oparation [ Wamings "Reforonca & Limits | Picture & Vector

Format
HD Formts

M isser Defined Foremat

Configuration
|"'Fnr|-|al Measuremants | Oparation [ Wamings "Reforonca & Limits | Picture & Vector

Format Color Space
HD Formts

User Defined Format

M User Defined Farmat i b - - -
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Umgang mit dem Geréat

3. Geben Sie Werte sowohl fiir die il
horizontalen als auch vertikalen
Parameter an, die das Format angeben.

m  Legen Sie den Abtasttyp fest.
B Legen Sie den Sync-Typ fest.

m  Geben Sie einen Wert fiir die
Framerate ein.

4. Geben Sie einen Formatnamen ein, und
wahlen Sie Save (Speichern) aus, um
das neue Format zu speichern.

5. Wenn Sie ein benutzerdefiniertes Format Configuration
verwenden méchten, aktivieren Sie das |Tt:a':|ewnemenm'Dpalallon Warmnings | Reference & Limits | Picture & Vector oo sy
Kontrollkastchen User Defined Format e
(Benutzerdefiniertes Format) auf der
Registerkarte Format. Wéhlen Sie das
gewnschte Format aus der Liste aus.

User

108 FoPr-Test!

Festlegen des Eingangssignalformats — Option VGA

1. Wahlen Sie Configuration > Format Configuration  Results
(Konfiguration > Format) aus.
Measurements
COperation
Warnings
Reference & Limits

Die Anwendung zeigt die Ansicht Gonfiguration _
Formatu (Format) an. [Format [Measurements | Operation [Warnings |Reference & Limits

Resolution Refresh Rate

User Defined Farmmat
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2. Wabhlen Sie die entsprechende Aufldsung
fir das gemessene Signal aus.

3. Wahlen Sie die Aktualisierungsrate fiir
das gemessene Signal aus. Je nach
der ausgewahlten Aufldsung sind einige
Aktualisierungsraten nicht auswéhlbar.

4. Wahlen Sie den ,Timing“-Standard fir g
das Signal aus. B

Erstellen eines benutzerdefinierten Formats

Wenn Sie ein Format priifen machten, das auf der Registerkarte ,Format* nicht aufgelistet ist, kdnnen Sie ein
benutzerdefiniertes Format erstellen.

1. Wahlen Sie Configuration > Format Configuration  Results
(Konfiguration > Format) aus.
Measurements
Operation
Warnings
Reference & Limits

Die Anwendung Zeigt die Ansicht & File Configuration Resuls Utiies Help
Configuration

,Format‘ (Format) an. I e e ey e e A

Configure

User Defined Format

e e . —_
2. Aktivieren Sie das Kontrollkastchen & o Conaion Rosudc_Uies sy
User-Defined Format (Foree oo Gsrai i | e s --
Resolution Refresh Rate Timing *

(Benutzerdefiniertes Format), um
ein benutzerdefiniertes Format
hinzuzufigen.

Configure

User Defined Format

-1
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3. Wahlen Sie Add (Hinzufiigen) aus, TN T
um die Parameter des neuen Formats (FarmatWazsuramont | Gperatio | Warvngs | afaranca & L
festzulegen. : . ‘ R

User Defined Format

User Defined Format

4. Geben Sie Werte sowohl fir die Create User Defined Format
horizontalen als auch vertikalen i
Parameter an, die das Format angeben.

®  Legen Sie die Sync-Polaritat fest.

m  Geben Sie einen Wert fir die
Aktualisierungsrate ein.

5. Geben Sie einen Formatnamen ein, und
wahlen Sie Save (Speichern) aus, um
das neue Format zu speichern.

6. Wenn Sie ein benutzerdefiniertes Format Configuration

verwenden mochten, aktivieren Sie das (oo i o O O AR A L

Kontrollkastchen User Defined Format 6 0 orz ® 100
(Benutzerdefiniertes Format) auf der 0 b
Registerkarte Format. Wahlen Sie das _ ;

gewnschte Format aus der Liste aus. I

1 @hHz_testl '

Auswahlen von Messungen

1. Waéhlen Sie Configuration> > Configuration  Results
Measurements> (Konfiguration > Farmat
Messungen) aus. e

COperation
Warnings

Reference & Limits

Ficture & Vectar
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2. Wahlen Sie auf der Registerkarte Configuration
”Measurementsu (Messungen) dle Fl:llmal|Meas||remems'Dpalallnn ‘Warnings | Reference & Limits | Picture & Vector
gewiinschten Messungen aus. Sie g G
konnen eine Messung oder eine e
beliebige Kombination von Messungen yrc.dine
auswahlen.

Configuration

asurements Operation | Warnings [ Reference & Limits

Option VGA

Festlegen der Ausfiihrungsoptionen fiir Messungen

1. Wéhlen Sie Configuration > Operation Corfiguration  Results
(Konfiguration > Betrieb) aus. Format

Measurements

Operation

Warnings
Reference & Limits
Ficture & Vector

Option SD/HD

Configuration  REesults

Format

Measurements

Warnings

Reference & Limits
Option VGA
Das Gerat zeigt die Ansicht ,Operation* Configuration
(Betrleb) an. Mlt H||fe dleser |f6r|r|at';’l7j'emren|elns I"W‘Wan‘u‘i‘ngs"I‘]eierem_-e & Limits | Picture & Vector
Einste”ungen erd festge|egt Wie Setup And/Or Run Run Mode Auto Scale Sync/Trigger

das Gerat nach Klicken auf ,Run”
(Ausfuhren) das Setup durchfiihrt und
die Messwerte erfasst.

Option SD/HD
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Umgang mit dem Gerat

Configuration
[ Format | Measurements  Dperation |Warnim]a [ Reference & Limits |

Setup AndiOr Fun Fam Made

EC
Restore Default

2. Legen Sie das Setup des Gerats fest,
und bestimmen Sie die Ausfiihrung von
Messungen.

= Mit Setup & Run (Setup & Ausflihren) werden die Geréateeinstellungen konfiguriert, und fiir jede ausgewahlte
Messung und jede Messungserfassung wird eine Messung durchgefhrt. Verwenden Sie diese Option, wenn
mehrere Messungen ausgefiihrt werden, die unterschiedliche Geratesetups erfordern.

®  Mit Setup Only (Nur Setup) kann das Gerat fiir eine Messung konfiguriert werden, es wird jedoch keine Messungen
ausgefihrt. Legen Sie mit Hilfe dieser Option benutzerdefinierte Einstellungen fest. Klicken Sie auf die Schaltflache
,Run“ (Ausfiihren), um die vorgenommenen Einstellungen zu testen, nehmen Sie die erforderlichen Anderungen vor
(@ndern Sie beispielsweise die Horizontalskala), und wahlen Sie die Schaltflache ,Run” (Ausflihren) erneut aus.
Wenn Sie mit den festgelegten Einstellungen zufrieden sind, sammeln Sie mit Hilfe der Einstellung ,Run Only*
(Nur ausfhren) die Ergebnisse.

= Mit Run Only (Nur ausfiihren) kann eine Messung mit der vorhandenen Geratkonfiguration durchgefiihrt werden.
Verwenden Sie diese Einstellung, um Messungen mit benutzerdefinierten Einstellungen durchzufiihren (siehe obige
Beschreibung zu ,Setup Only* (Nur Setup)).

3. Sie konnen auswahlen, wie die Run Mode
Anwendung Messungen erfasst (,Run
Mode" (Betriebsmodus)).

= Mit Once (Einmal) wird jede ausgewahlte Messung so oft ausgefiihrt, wie von der Durchschnittseinstellung
angegeben, und anschlieend wird die Ausfiihrung von Messungen beendet. Hierbei handelt es sich um die
Standardeinstellung.

= Mit Continuously (Fortlaufend) kénnen fortlaufend Messungen durchgefiihrt werden. Sie miissen die Schaltflache
,otop* (Anhalten) auswahlen, um die Messungen anzuhalten.

m  Mit Once & Report (Einmal & Bericht) wird jede ausgewahlte Messung so oft ausgefiihrt, wie von der
Durchschnittseinstellung angegeben, und anschlieRend wird die Ausflihrung von Messungen beendet und ein
Bericht generiert.
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4. Aktivieren oder deaktivieren Sie ,Auto

Scale” (Automatisch skalieren). Mit
LAuto Scale* (Automatisch skalieren)
konnen die vertikalen Skaleneinheiten
so angepasst werden, dass die
Eingangssignale das Raster so weit
wie moglich ausfiillen. ,Auto Scale*
(Automatisch skalieren) wird einmal fiir
jede ausgewahlte Messung angezeigt.

. Option SD/HD: Wahlen Sie aus,

an welchem Kanal des Geréts das
Sync-Signal fiir die Triggerung anliegt.

Wenn Sie den falschen Triggerkanal
verwenden, wird eine Signalwarnung
ausgegeben (wenn ,Signal Warnings'
(Signalwarnungen) aktiviert ist).
(Siehe Seite 9, Verbinden von
Eingangssignalen.)

. Wahlen Sie die entsprechende

Einstellung fir Line Select
(Zeilenauswahl) aus. Im Modus
Single Line (Einzelne Zeile) wird jede
Messung fiir eine einzelne Zeile (z. B.
Zeile 153) ausgefihrt. Im Modus
Multiple Lines (Mehrere Zeilen) werden
Messungen uber einen Bereich von
Zeilen (z. B. Zeilen 153 bis 185)
ausgefiihrt.

Wenn Sie ,Multiple Lines" (Mehrere
Zeilen) auswahlen, wird automatisch ein
Bericht in einer Datei gespeichert.

. Option VGA: Wenn Sie die

RGBHV-Messschnittstelle verwenden,
miissen Sie das Kontrollkastchen Use
MIU (Messschnittstelle verwenden)
aktivieren.

Auto Scale

Enahled

Initial Values

Option SD/HD

Line Select
@ Single Line
® Multi Lines

Configuration

[ Format | Measurements | Operation [Warnings | Reference & Limits |

Option VGA
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8. Option VGA: Wenn Sie die Configuration

[ Format | Measurements | Operation [Warnings | Reference & Limits |

Messschnittstelleneinheit verwenden,
kénnen Sie die Einstellung Sync Polarity
(Sync-Polaritat) ignorieren.

Da die angegebenen Polaritaten fir die H Sync- und V Sync-Signale zwischen den Timing-Standards variieren, werden
Sie vom System der Serie VM aufgefordert, die H Sync- und V Sync-Signale anzuschlieBen und auf diese Weise
automatisch ihre Polaritat zu bestimmen. Wenn die Polaritat der Sync-Signale festgelegt ist, beginnt der Messzyklus.
Dieser ,Polaritatstest” wird zu Beginn jedes Messzyklus ausgefiihrt. Um zu vermeiden, dass ein solcher Test zu Beginn
eines jeden Messzyklus ausgefiihrt wird, flihren Sie nur dann Messungen aus, wenn Auto Detect (Automatisch erfassen)
ausgewahlt ist. Wenn ein Messzyklus bei aktivierter Option Auto Detect (Automatisch erfassen) abgeschlossen wurde,
kénnen Sie Auto Detect (Automatisch erfassen) deaktivieren. Sie werden dann nicht aufgefordert, die Signale fiir die
Polaritatsprifung erneut zu &ndern (die Polaritat der Sync-Signale wird vom System der Serie VM gespeichert). Wenn
Sie die Formateinstellung fir den Priifling &ndern, sollten Sie jedes Mal einen Messzyklus ausfihren, wobei Auto Detect
(Automatisch erfassen) aktiviert sein muss.

9. Wahlen Sie aus, welche Warnmeldungen Eahgtn _
angezeigt Werden SO”en | Format | Measurements | Operation [Warnings | Reference & Limits

Weitere Informationen tber Warnungen Warning Types R Control Options
finden Sie im Benutzerhandbuch fiir das
Videomesssystem der Serie VM.

Schnellstart-Benutzerhandbuch fiir Videomesssysteme der Serie VM 41



Umgang mit dem Gerat

Ausfiihren und Anzeigen von Messungen

Vor dem Ausflhren einer Messung miissen Sie ein Signalformat auswahlen, die gewiinschten Messungen auswahlen
und die Ausflihrungsoptionen konfigurieren.

42

1.

Klicken Sie auf die Schaltflache
,Run® (Ausfihren). Die Ausfihrung
der Messungen wird begonnen, und
die Messergebnisse flr die zuletzt
ausgewéhlten Messungen werden
angezeigt.

Wenn Sie die Ergebnisse einer anderen
Messung anzeigen mochten, wahlen
Sie im Meni ,Results* (Ergebnisse)
die betreffende Messung aus. Wahlen
Sie beispielsweise Results > Sync
(Ergebnisse > Sync) aus, um die
Sync-Messergebnisse anzuzeigen.

Wenn die Ausfihrung auf ,Continuously*
(Fortlaufend) festgelegt ist, klicken Sie
auf die Schaltflache Stop (Anhalten),
um die Ausfiihrung der Messungen zu
beenden.

Results: Color Bars

Focmat
HD 1080150

Line Humber

Results: Coler Bars |m| —| R —|

Formit
BOOxGE00_60Hz fiit

fwerage

Option VGA
Results  Utilities Help
* Summnisng
Channel Delay Short Time Distortion
Color Bars Spatial Distortion
Frequency Response H Sync
Multiburst W Sync
Moise H Syne Jitter
Man Linearity Levels
Option SD/HD
Results  Utilities  Help
+ Summary Ch-Ch Skew
H Syne Luma Levels
W Sync Moise Inj Ratio
H Timing Linearity
W Timing Wideo Transient
Color Bars H Syne Jitter
Ch-Ch Mismatch
Option VGA

oxrl
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Verwenden des Oszilloskops

Wenn Sie Standardfunktionen des Oszilloskops der Serie VM zum Ausflihren von Messungen oder zum Anzeigen der
Eigenschaften eines Signals verwenden mdchten, blenden Sie einfach die Software der Serie VM aus. Sie missen die
Software fiir die Serie VM nicht beenden.

1. Wahlen Sie Hide (Ausblenden) aus, R e e e e e D e P e e
um die Software fiir die Serie VM
auszublenden. : '* ells BT -

HERREER ==

&P 200mvidiv e S 15V 50.0ps 500MS/s 2.0ns/pt
D 500mVidiv Trig Diy: 10 events Ru Sample
TP 200mvidiv Be» /222y 84 acqs RL:250k
«@» 1ovidiv T | October 10, 2006 3
€ File Configuration  Results Uliities Help
Configuration
Format [Measurements | Operation | Warnings | Reference & Limits
Resoluti Refresh Rate Timing

AT

_ _ Configure
® 70Kz ®GTF

User Defined Format

Wenn die Software fir das System pue | ot | vetcn | orasen| 1 | ospiy | eor e | s | v | ysops | s | unes | v [
der Serie VM ausgeblendet ist, belegt

die Oszilloskopanzeige den gesamten
Bildschirm. Auf dem Bildschirm wird kein
Hinweis ausgegeben, dass die Software fiir
das System der Serie VM ausgeblendet ist.

&P 200mVidiv [ /sy 50.0ps 500MS/s 2.0ns/pt
& s00mvidiv Trig Diy: 10 events Ru sample

TP 200mvidiv (5 Lo WRREY 242acqs RL:250k
@ 1ovidiv T | october 0, 2006 19

2. Wahlen Sie Restore Application
(Anwendung wiederherstellen) aus, um
die Software fur die Serie VM wieder
anzuzeigen.

Wi HD and S0 Wideo

Wh S8 Wideo
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Umgang mit dem Gerat

Fehlerbehebung bei Signalproblemen

Wenn beim Ausfiihren der Messungen Probleme auftreten, erhalten Sie mdglicherweise Warn- oder Fehlermeldungen,
die Sie beim Ermitteln der Ursache des Problems unterstiitzen. In den folgenden Tabellen werden die Meldungen und die
maglichen Ursachen fiir Probleme beschrieben.

Warnmeldungen fiir die Option SD/HD

Nummer

Text

Mégliche Ursachen

Eventuell betroffener
Vorgang

1

Acquisition Problem (Problem bei der
Erfassung)

Das Gerat kann kein Signal erzeugen,
oder die Signalpegel liegen auflerhalb
des zulassigen Bereichs.

Alle Messungen

Bar Measurements Inconclusive
(Balkenmessungen ohne Ergebnis)

Das Gerét kann keine entsprechende
Synchronisation ermitteln, das
falsche Format ist ausgewahlt, oder
das Signal ist verzerrt.

Messung kurzzeitiger
Verzerrungen

Channel Delay: Channel <x>

& <y>, Correlation Too Low
(Kanalverzgerung: Kanal <x> & <y>,
Korrelation zu gering)

Die Zeilennummer ist falsch
festgelegt, ein verzerrtes Signal oder
ein ungeeignetes Eingangssignal
mit einer zu kleinen Anzahl von
Ubergéngen.

Messung der
Kanalverzdgerung

Channel Delay: Disjoint
Correlations Among Channels...
(Kanalverzdgerung: disjunkte
Korrelationen zwischen Kandlen...)

Zwischen den Kanalen liegt ein
Gruppenverzogerungskonflikt vor,
oder es wird eine ungeeignete
Signalquelle verwendet.

Messung der
Kanalverzgerung

Color Bars: <Color> Bar Not Found
(Farbbalken: Balken <Farbe> nicht
gefunden)

Die Zeilennummer ist falsch
festgelegt, ein verzerrtes Signal,
ein falsches Format ist angegeben,
die angeschlossenen Kanale liegen
in der falschen Reihenfolge vor,
eine falsche Farbmessung oder
ubermaRiger Beschnitt des Signals.

Messung von
Farbbalken

Color Bars: Back Porch
Reference Questionable

(Farbbalken: zweifelhafte
Schwarzschalterreferenz)

Das Signal ist verzerrt.

Messung von
Farbbalken

Frequency Response: Signal
Change: <freq1> 3 <freq2> MHz
(Frequenzgang: Signalanderung:
<Freq1> 3 <Freq2> MHz)

Signalpegel ist zu niedrig, falsches
Signal oder eine Anderung innerhalb
des Signals.

Messung des
Frequenzgangs

Frequency Response Individual
Channel Errors: Channel <x>
(Fehler bei einzelnem Kanal fiir
Frequenzgang: Kanal <x>)

Das Signal ist verzerrt, oder im Signal
fehlt ein Flag.

Messung des
Frequenzgangs

Frequency Response: Invalid results
for all channels (Frequenzgang:
Ungiiltige Ergebnisse fiir alle Kanéle)

Die Zeilennummer ist falsch
festgelegt, ein ungeeignetes
Eingangssignal oder eine falsche
Konfiguration.

Messung des
Frequenzgangs

44
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Warnmeldungen fiir die Option SD/HD (Fortsetzung)

Nummer

Text

Mogliche Ursachen

Umgang mit dem Gerat

Eventuell betroffener
Vorgang

10

Multiburst: Signal Change: <freq1>
3 <freq2> MHz (Mehrfachburst:
Signalanderung: <Freq1> * <Freq2>
MHz)

Signalpegel ist zu niedrig, falsches
Signal oder eine Anderung innerhalb
des Signals.

Messung von
Mehrfachburst

"

Multiburst: Individual Channel
Errors: Channel <x>: Flag <= 0 mV
(Mehrfachburst: Fehler bei einzelnem
Kanal: Kanal <x>: Flag <= 0 mV)

Das Signal ist verzerrt, oder im Signal
fehlt ein Flag.

Messung von
Mehrfachburst

12

Multiburst: Individual Channel Errors:
Channel <x>: burst <n>: not detected
(Mehrfachburst: Fehler bei einzelnem
Kanal: Kanal <x>: Burst <n>: nicht
erkannt)

Signalpegel ist zu niedrig, verzerrte
Signale, ein Eingangssignal mit
weniger als sechs Frequenzpaketen
oder GibermaRiger Beschnitt des
Signals.

Messung von
Mehrfachburst

13

Multiburst: Invalid results for all
channels (Mehrfachburst: Ungiiltige
Ergebnisse fir alle Kanéle)

Die Zeilennummer ist falsch
festgelegt, ein ungeeignetes
Eingangssignal oder eine falsche
Konfiguration.

Messung von
Mehrfachburst

14

Noise: Signal Change: Chan <x>
(Rauschen: Signalanderung: Kanal
<x>)

Das Signal hat sich wahrend der
Messung geandert.

Messung von Rauschen

15

Noise: Invalid results for all channels
(Rauschen: Ungiiltige Ergebnisse fiir
alle Kanéle)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung von Rauschen

16

Nonlinearity: Invalid Results: Channel
<x>: No ramp or step signal found
(Nichtlinearitat: Ungiiltige Ergebnisse:
Kanal <x>: Kein Rampen- oder
Stufensignal gefunden)

Die Zeilennummer ist falsch
festgelegt, oder es liegt ein
ungeeignetes Eingangssignal an.

Messung von
Nichtlinearitat

17

Nonlinearity: Signal Change: Channel
<x>: (Nichtlinearitat: Signaldnderung:
Kanal <x>:)

Das Signal hat sich wahrend der
Messung geandert.

Messung von
Nichtlinearitat

18

Short Time Distortion: Bar Start
Not Found (Kurzzeitige Verzerrung:
Balkenanfang nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, das Signal ist verzerrt,
oder es wurde ein falsches Format
ausgewahlt.

Messung kurzzeitiger
Verzerrungen

19

Short Time Distortion: Bar End
Not Found (Kurzzeitige Verzerrung:
Balkenende nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, das Signal ist verzerrt,
oder es wurde ein falsches Format
ausgewahlt.

Messung kurzzeitiger
Verzerrungen

20

Short Time Distortion: Invalid
results for Channel<x> (Kurzzeitige
Verzerrung: Ungliltige Ergebnisse fir
Kanal <x>)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung kurzzeitiger
Verzerrungen
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Umgang mit dem Gerat

46

Warnmeldungen fiir die Option SD/HD (Fortsetzung)

Eventuell betroffener

Nummer Text Mogliche Ursachen Vorgang
Al Sync Measurements Inconclusive Das Gerét kann keine entsprechende Messung der
(Sync-Messungen ohne Ergebnis) Synchronisation ermitteln, das Synchronisation
falsche Format ist ausgewahlt, oder
das Signal ist verzerrt.
22 Sync Measurement: <n> Not Found Das Gerét kann keine entsprechende Messung der
(Sync-Messung: <n> nicht gefunden) Synchronisation finden. Synchronisation
23 2T pulse not found in luminance Die Zeilennummer ist falsch Messung kurzzeitiger
component of signal (2T-Puls in festgelegt, ungeeignetes Verzerrungen
Luminanzkomponente des Signals Eingangssignal oder falsche
nicht gefunden) Konfiguration.
24 Writing over file <filename> (Datei Das Gerat Uberschreibt eine Abrufen von
<Dateiname> wird Uiberschrieben) vorhandene Datei. Einstellungen;
Generieren eines
Berichts
25 Sync Acquisition Problem: Triggerung

(Problem bei der Erfassung der
Synchronisation:) Entweder das
Gerat kann kein Signal erzeugen,
oder die Signalpegel liegen aulerhalb
des glltigen Bereichs.

Warnmeldungen fiir die Option VGA

Eventuell betroffener

Nummer Text Mdgliche Ursachen Vorgang

1 Sync edge locations questionable. Das Format ist falsch festgelegt. Messung von H Sync,
Make sure that the selected V Sync und V Timing
format is correct. (Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewahlt wurde.)

2 H Timing: Incorrect signal in Channel Das Format ist falsch festgelegt. Messung von H Timing

<1-3>. Use Black-White-Black
signal. Sync edge locations
questionable. Make sure that the
selected format is correct. (H Timing:
Falsches Signal in Kanal <1-3>.
Verwenden Sie das Schwarz-Weil-
Schwarz-Signal. Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewahit wurde.)
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Warnmeldungen fiir die Option VGA (Fortsetzung)

Umgang mit dem Gerat

Eventuell betroffener

Nummer Text Mégliche Ursachen Vorgang
3 H Timing: Incorrect signal in Channel Das Schwarz-WeiR-Schwarz-Signal Messung von H Timing
<1-3>. Use Black-White-Black wird nicht verwendet.
signal. (H Timing: Falsches Signal
in Kanal <1-3>. Verwenden Sie das
Schwarz-Weil-Schwarz-Signal.)
4 Invalid Results: Acquisition Problem: Erfassung fehlgeschlagen: Trigger Alle Messungen
Either cannot trigger or the signal fehlt, falsches Format oder andere
levels are out of range or acquired Ursache fiir die fehlgeschlagene
less than the requested samples. Erfassung des Signals.
(Ungiltige Ergebnisse: Problem
bei der Erfassung: Entweder kann
kein Signal erzeugt werden, oder
die Signalpegel liegen aullerhalb
des zulassigen Bereichs, oder es
wurden weniger als die angeforderten
Abtastwerte erfasst.)
5 Linearity: Signal Change: Channel Stabilitatsproblem wahrend der Messung der Linearitat
<x>: (Linearitat: Signalanderung: kontinuierlichen Ausfiihrung: Die
Kanal <x>:) Rampe ist nicht mehr vorhanden,
oder die Anzahl der Stufen hat sich
geéandert.
6 Linearity: Signal Fidelity Problem: Bei zweizeiligen Rampen (unterer Messung der Linearitat
Channel <x> Resolution mismatch: Bereich der Rampe in einer Zeile und
Line A<x> bits, Line B <y> bits: oberer Bereich der Rampe in der
Steps not found (Problem mit der zweiten Zeile) stimmt die Bitaufldsung
Signalwiedergabe: Kanal <x> der LSB-Treppenrampen nicht
Aufldsungskonflikt: Zeile A <x> Uberein, oder die Gesamtzahl der
Bits, Zeile B <y> Bits: Stufen nicht Stufen entspricht nicht (2*n — 1).
gefunden)
7 Linearity: Error occurred in switch Die RGBHV-Messschnittstellenein- Messung der Linearitat
accessory (Linearitat: Fehler in heit reagiert nicht ordnungsgeman.
Austauschzubehor)
8 Sync edge locations questionable. Das Format ist falsch festgelegt. Messung von

Make sure that the selected
format is correct. (Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewahlt wurde.)

Farbbalken,
Videokanalkonflikt,
Kanal-zu-Kanal-
Zeitversatz,
Luminanzstufen,
Videokanalkonflikt,

V Sync, V Timing und
Video-Transiente.
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Umgang mit dem Gerat

48

Warnmeldungen fiir die Option VGA (Fortsetzung)

Nummer

Text

Mogliche Ursachen

Eventuell betroffener
Vorgang

9

Color Bars: Yellow/Cyan/Green/Ma-
genta/Red/Blue/Black Bar

not found. (Farbbalken:

Balken Gelb/Zyan/Griin/Ma-
genta/Rot/Blau/Schwarz nicht
gefunden.)

Das Farbbalkensignal wird nicht
verwendet.

Messung von
Farbbalken

10

Ch-Ch Skew: Incorrect signal in
Channel <1-3>. Use the Alternate
White and Black bar signal. (Versatz
zwischen Kanalen: Falsches Signal
in Kanal <1-3>. Verwenden Sie das
Signal mit alternierenden weiflen und
schwarzen Balken.)

Das Format ist falsch festgelegt.

Messung des Versatzes
zwischen Kanalen

11

Ch-Ch Skew: Incorrect signal in
Channel <1-3>. Use the Alternate
White and Black bar signal.
(Luminanzstufen: Falsches Signal

in Kanal <1-3>. Verwenden Sie das
Signal mit alternierenden weilen und
schwarzen Balken.)

Alternierendes WeiR-Schwarz-Signal
wird nicht verwendet.

Messen von
Luminanzstufen

12

Video Transient: Incorrect signal

in Channel <1-3>. Use the
Alternate White & Black bar signal.
(Video-Transiente: Falsches Signal
in Kanal <1-3>. Verwenden Sie das
Signal mit alternierenden weilen und
schwarzen Balken.)

Alternierendes Weil3-Schwarz-Signal
wird nicht verwendet.

Messen von
Video-Transienten

13

H Sync Jitter: Sync edge locations
questionable. Make sure that

the selected format is correct.

(H Sync Jitter: Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewahit wurde.)

Das Format ist falsch festgelegt.

Messung von
H Sync-Jitter

14

Noise: Invalid results for some
channels. (Rauschen: Ungiiltige
Ergebnisse fiir einige Kanéle.)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung von Rauschen

15

Ch-Ch Mismatch: Incorrect signal in
Channel <1-3>. Use the 32-step
Staircase signal in true color mode.
(Konflikt zwischen Kanélen: Falsches
Signal in Kanal <1-3>. Verwenden
Sie das 32-stufige Treppensignal im
True Color-Modus.

Treppensignal mit 32 Stufen wird
nicht verwendet

Messung von Konflikten
zwischen Kanalen
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Fehlermeldungen

Nummer Text

Mégliche Ursachen

Umgang mit dem Gerat

Eventuell betroffener
Vorgang

1 File Name Error: File doesn’t exist:
<filename> (Dateinamenfehler: Datei
ist nicht vorhanden: <Dateiname>)

Die ausgewahlte VMSET-Datei

ist nicht vorhanden. (Sie missen
den vollstandigen Pfad angeben,
wenn sich die Datei nicht im Ordner
C:\VMApps\ befindet.)

Abrufen von
Einstellungen

2 Cannot write file: file already
exists: <filename> (Datei kann nicht
geschrieben werden: Datei ist bereits
vorhanden: <Dateiname>)

Der <Dateiname> muss geandert
werden, damit die Datei gespeichert
werden kann.

Speichern von
Einstellungen;
Generieren von
Berichten

3 File Name Error. Invalid character(s)
in file name (Dateinamenfehler.
Ungiltige Zeichen in Dateiname)

Ungiiltige Zeichen im Dateinamen.
Die folgenden Zeichen sind ungiiltig:
R R \fund 7

Speichern von
Einstellungen;
Generieren von
Berichten

4 No Measurement Selected (Es wurde
keine Messung ausgewahlt)

Im Meni ,Configuration >
Measurements” (Konfiguration
> Messungen) wurden keine
Messungen ausgewahit.

Ausfihren von
Messungen; Generieren
eines Berichts

5 Cannot create Report. Not all selected
measures have been Run (Bericht
kann nicht erstellt werden. Nicht alle
ausgewahlten Messungen wurden
ausgefiihrt.)

Sie mussen eine Messung ausfiihren
und warten, bis diese abgeschlossen
ist, bevor ein Bericht generiert werden
kann.

Generieren von
Berichten.

6 Invalid Filename (Ungdltiger Die Datei ist nicht vorhanden, oder Aufrufen von Einstel-
Dateiname) der Pfad ist falsch. Sie missen lungen,Speichern von
den vollstandigen Pfad angeben, Einstellungen, Gener-
wenn sich die Datei nicht im Ordner ieren von Berichten
C:\VMApps befindet. (nur wenn Uber GPIB
aufgerufen)
7 Invalid Argument (Ungliltiges Fir den betrefifenden GPIB-Befehl Alle GPIB-Befehle
Argument) wurde ein falsches Argument
verwendet.
8 Command Overflow (Befehlstiberlauf) Die GPIB-Befehle wurden zu Beim zu schnellen

schnell gesendet. Verldngern Sie
die Verzdgerung zwischen zwei
Befehlen, um dieses Problem

zu vermeiden (Intervalle von

100 Millisekunden empfohlen), oder
verwenden Sie Handshaking mit
OPComplete.

Senden von
GPIB-Befehlen.
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Fehlermeldungen (Fortsetzung)

Eventuell betroffener

Nummer Text Mogliche Ursachen Vorgang
9 Command Missed (Befehl fehlt) Dieser Fehler gibt an, dass ein in der Senden von
letzten Sekunde gesendeter Befehl GPIB-Befehlen

eventuell nicht verarbeitet wurde.
Deshalb sollten Sie zuriick zu einer
aktuellen (bekannten) Konfiguration
wechseln und die letzten Befehle
erneut senden.

10 Error occurred in configuring MIU Falsche serielle Verbindung zur Ausflihren von Mes-
(Fehler bei der Konfiguration der Messschnittstelleneinheit, oder sungen mit Hilfe der
Messschnittstelleneinheit) eines der CH1/-CH2-/CH3-/CH4- Messschnittstellenein-

Anschlusskabel ist vom System der heit.

Serie VM getrennt.
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Anwendungen

Einfache Farbbalkenmessung - Optionen SD/HD

Amplitudenmessungen werden normalerweise mit dem Farbbalkenprifsignal ausgefiihrt, das die RGB-Komponenten

ein- und ausschaltet, sodass alle acht mdglichen Farbkombinationen (WeiB, Gelb, Zyan, Griin, Magenta, Rot, Blau und
Schwarz) entstehen kénnen. Es gibt verschiedene Formen des Farbbalkenpriifsignals, von denen jedes einen maximalen
dynamischen Bereich von 700 mV = 100 % oder 75 % bei einer RGB-Amplitude von 525 mV verwendet. In den folgenden
Tabellen sind die Amplitudenbereiche fiir die Komponente Y'P'bP'r fiir die verschiedenen Standards von 100 %- und

75 %-Farbbalken angegeben.

Amplitudenbereiche fiir verschiedene 100 %-Farbbalkensignalformate

480p/576p 1080/720

Farb- R G B Y Pb Pr Y Pb Pr
balken (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV)
Weily 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0
Gelb 700 700 0 6202 -349.8 56.9 649.5  -350.0 321
Zyan 0 700 700 4907 1180  -349.9 55612 80.2 -350.0
Grin 0 700 0 4109  -231.7  -293.0 5006  -269.8 -317.9
Magenta 700 0 700 2891 2317 293.0 1994 2698 3179
Rot 700 0 0 209.3  -118.0 3499 1488 -802  350.0
Blau 0 0 700 79.8 3498  -56.9 50.5 350.0  -321
Schwarz 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

Amplitudenbereiche fiir verschiedene 75 %-Farbbalkensignalformate

480p/576p 1080/720
Farb- R G B Y Pb Pr Y Pb Pr
balken (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV)
Weily 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0
Gelb 525 525 0 4652  -262.3 427 4871  -2625 241
Zyan 0 525 525 368.0 885 -262.4 4134  60.2 -262.5
Grlin 0 525 0 308.2 -173.8 -219.7 3755  -202.3 -238.4
Magenta 525 0 525 2168 1738 2197 1495 2023 2384
Rot 525 0 0 1570  -88.5 262.4 M6  -602 262.5
Blau 0 0 525 59.9 2623 427 37.9 2625  -24.1
Schwarz 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

Schnellstart-Benutzerhandbuch fiir Videomesssysteme der Serie VM 51



Anwendungen

Je nach dem zu testenden Gerat ist eine Abweichung der tatsachlichen Werte zulassig. Beispielsweise kdnnen von den
progressiven Ausgangen von DVD-Playern Einstellungen fiir die zugehdrigen Ausgénge eingefiihrt werden, die die
Gesamtmessergebnisse beeinflussen kdnnen. Abweichungen der Ebene der Komponenten kénnen unterschiedliche
Farbténe und Séttigungen des angezeigten Bildes bewirken. Das Farbbalkenprifsignal ermoglicht es Ihnen,
Verstarkungsabweichungen zwischen den Kanalen zu bestimmen und sicherzustellen, dass das Signal nicht verzerrt ist.
Dies kénnte eine starke Signalamplitudenbegrenzung zur Folge haben.

Das Tektronix-Matrixmuster verwendet ein 100 %-Farbbalkensignal, um den vollen dynamischen Bereich jeder Komponente
zu testen. Das Farbbalkenmuster befindet sich nahe dem oder im oberen Bereich des Matrixmusters; die Zeilennummern,
an denen es auftritt, sind fiir jeden Standard unterschiedlich. Die angegebenen Zeilennummern sind die Standardwerte
zum Generieren der Testmatrix, aber bei einigen zu priifenden Systemen verschieben sich mdglicherweise die Zeilen

im Bild an eine andere Position.

Format 1080i 720p 480p 576p
Zeile 21-84 26 - 153 43 - 106 45-108
Quelle 584 - 647

Das System der Serie VM flihrt die Farbbalkenmessungen aus, indem zundchst die relative Amplitude fir jeden der

drei Kanéle ermittelt wird. Acht Amplitudenmessungen werden auf jedem Kanal vorgenommen, das sind insgesamt

24 Messungen in weniger als einer halben Sekunde. Anhand der folgenden Schritte werden die typischen Messergebnisse
fir ein 1080i-Signal gezeigt. Die Amplitude fiir jede Balkenhdhe wird in Bezug auf den Schwarzschalter gemessen.
Amplituden werden mit Werten von gemittelten Signalen in jedem ermittelten Balken berechnet. Deshalb ist es wichtig
sicherzustellen, dass das Video vollstandig im Erfassungsfenster des Instruments angezeigt wird, wenn am Geréat manuelle
Einstellungen vorgenommen wurden.

1. Schalten Sie das Gerét ein. [ r—w—
5"'3”3’8
o

o|@

Q olos

o (=] o o

(o] o] o o]

@ 0000
E

2091-017

2. Wahlen Sie Analyze > VM HD and |
SD Video (Analysieren > VM HD- und Sl | Lflil=s | el
SD-Video).

Restore Application

Ml HD and =0 Yideo

W WG, Video
3. Wahlen Sie in der Anwendung File Configuration Resu
des Systems der Serie VM File _RIEEE” Default Setup
> Recall Default Setup (Datei > Recall Setup...
Grundeinstellungen abrufen) aus, um Save Setup.
alle Einstellungen auf die werkseitigen Minimize

Standardwerte zurlickzusetzen.
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4. Legen Sie ein Signal an die Eingange
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

5. Stellen Sie das Eingangssignalformat
ein. (Siehe Seite 33, Festlegen des
Eingangssignalformats — Optionen

SD/HD.)
6. Wahlen Sie Configuration > [T—

Measurements (Konflguratlon > (Fermat [Measurements | Operation Wamingﬂlﬂefelence &I.Imiu[l‘imre & Vector

Messungen) aus. 3

Beachten Sie, dass in der . c

C Jitter

Standardeinstellung ,Color Bars*
(Farbbalken) ausgewahlt ist.

7. Klicken Sie auf die Schaltflache ,Run”
(Ausfiihren). @ :ﬁ' \

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt.

Einfache Farbbalkenmessung - Option VGA

Amplitudenmessungen werden normalerweise mit dem Farbbalkenprifsignal ausgefiihrt, das die RGB-Komponenten
ein- und ausschaltet, sodass alle acht méglichen Farbkombinationen (Wei3, Gelb, Zyan, Griin, Magenta, Rot, Blau und
Schwarz) entstehen kénnen. Es gibt verschiedene Formen des Farbbalkenpriifsignals, von denen jedes einen maximalen
dynamischen Bereich von 700 mV = 100 % oder 75 % bei einer RGB-Amplitude von 525 mV verwendet. In der folgenden
Tabelle wird die Amplitude fir das RGB-Signal bei 100 % und 75 % dargestellt.
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Amplitude fiir 100 %-Farbbalkensignal

Farbbalken R (mV) G (mV) B (mV)
Weil} 700 700 700
Gelb 700 700 0

Zyan 0 700 700
Grlin 0 700 0
Magenta 700 0 700
Rot 700 0 0

Blau 0 0 700
Schwarz 0 0 0

Amplitude fiir 75 %-Farbbalkensignalformate

Farbbalken R (mV) G (mV) B (mV)
Weily 700 700 700
Gelb 525 525 0

Zyan 0 525 525
Griin 0 525 0
Magenta 525 0 525
Rot 525 0 0

Blau 0 0 525
Schwarz 0 0 0

Das Tektronix-Matrixmuster verwendet ein 100 %-Farbbalkensignal, um den vollen dynamischen Bereich der einzelnen
Komponenten zu testen. Das Farbbalkenmuster befindet sich nahe dem oder im oberen Bereich des Matrixmusters;

die Zeilennummern, an denen es auftritt, sind fiir jedes Format unterschiedlich. In den folgenden Tabellen sind die
Zeilennummern aufgefiihrt, in denen sich die unterschiedlichen Muster im Matrixsignal bei einer Aktualisierungsrate von
60 Hz befinden. Bei anderen Aktualisierungsraten kann die tatsachliche Ausgangszeilennummer deutlich von der Rate
von 60 Hz abweichen. Um die Position der aktiven Videozeilennummer fir ein bestimmtes Muster bei einer anderen
Aktualisierungsrate anzeigen zu lassen, suchen Sie die Microsoft Excel-Datei ,Matrix.xIs*, die sich auf der Software-CD fr
das System der Serie VM befindet. In dieser Datei sind die tatsachlichen aktiven Videozeilennummern fir alle unterstiitzten
Aktualisierungsraten aufgelistet.

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (640 x 480
bis 1280 x 1024)

Muster 640 x 480 800 x 600 1024 x 768 1280 x 1024
Halfte weil und Halfte schwarz 36 -83 28 - 87 36 - 112 42 - 143
Neun Farbbalken 84 -179 88 — 207 113 - 265 144 - 348
32 Stufen 180 - 227 208 - 267 266 - 342 349 - 450
Alternierend Weil} und Schwarz 228 - 275 268 - 327 343 - 419 451 -552
Schwarz/weiR/schwarz 276 - 323 328 - 387 420 - 496 553 - 654
Vollweily 324 - 371 388 - 447 497 - 572 655 — 756
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Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (640 x 480
bis 1280 x 1024) (Fortsetzung)

Muster 640 x 480 800 x 600 1024 x 768 1280 x 1024
Rampe 372 - 467 448 - 567 573 - 726 757 - 962
Halfte weill und Halfte schwarz 468 - 515 568 — 627 727 - 803 963 — 1065

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (1600 x 1024
bis 1900 x 1200)

Muster 1600 x 1024 1600 x 1200 1920 x 1080 1920 x 1200
Hélfte weil und Halfte schwarz 36 -132 50 - 169 38 - 140 43 -162
Neun Farbbalken 143 - 337 170 - 409 150 - 356 163 - 402
Treppe 347 - 439 410 - 529 366 — 464 403 - 522
Alternierend Weil und Schwarz 450 - 542 530 - 649 474 - 572 523 - 642
Schwarz/weil/schwarz 552 - 644 650 - 769 582 - 680 643 — 762
Vollweily 655 - 747 770 - 889 690 — 788 763 — 882
Rampe 757 — 951 890 - 1129 798 — 1004 883 - 1122
Hélfte weil und Halfte schwarz 962 - 1059 1130 - 1249 1014 - 117 1123 - 1242

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (1920 x 1440

bis 2048 x 2048)

Muster 1920 x 1440 2048 x 1536 2048 x 2048
Halfte weill und Halfte schwarz 50 -193 53 - 198 71-265
Neun Farbbalken 194 — 481 213 - 505 285 - 674
Treppe 482 - 625 520 - 659 695 — 879
Alternierend Weil und Schwarz 626 - 769 674 - 812 899 - 1084
Schwarz/weil/schwarz 770 -913 828 - 966 1104 — 1289
Vollweil3 914 - 1057 981 - 1120 1309 - 1493
Rampe 1058 — 1345 1135 - 1427 1514 - 1903
Halfte weill und Halfte schwarz 1346 - 1489 1442 - 1588 1923 - 2118
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Das System der Serie VM filhrt die Farbbalkenmessungen aus, indem zunéchst die relative Amplitude fiir jeden der

drei Kanale ermittelt wird. Acht Amplitudenmessungen werden auf jedem Kanal vorgenommen, das sind insgesamt

24 Messungen in weniger als einer halben Sekunde. Anhand der folgenden Schritte werden die typischen Messergebnisse
fiir ein 1024 x 768-Signal gezeigt. Die Amplitude fiir jede Balkenhdhe wird in Bezug auf den Schwarzschalter gemessen.
Amplituden werden mit Werten von gemittelten Signalen in jedem ermittelten Balken berechnet. Deshalb ist es wichtig
sicherzustellen, dass das Video vollstandig im Erfassungsfenster des Instruments angezeigt wird, wenn am Gerét manuelle
Einstellungen vorgenommen wurden.

1.

56

Schalten Sie das Gerat ein.

Wahlen Sie Analyze > VM VGA Video
(Analysieren > VM VGA-Video).

Wahlen Sie in der Anwendung

des Systems der Serie VM File

> Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zuriickzusetzen.

Legen Sie ein Signal an die Eingénge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

Wahlen Sie das Eingangssignalformat
aus. (Siehe Seite 35, Festlegen des
Eingangssignalformats — Option VGA.)

Wahlen Sie Configuration >
Measurements (Konfiguration >
Messungen) aus.

Beachten Sie, dass in der

Standardeinstellung ,Color Bars*
(Farbbalken) ausgewahlt ist.
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Analyze | Lilties | Help

Restore Application

Wi HD and =0 Wideo

Whi W8 Wideo

BN Configuration  Resu

Recall Default Setup

Recall Setup...
Save Setup...
Minimize

Ewit

Configuration

| Iéomlal.l"l'-leasllremams Operaﬁnn V‘!amings“"R‘;l‘amncz &L

M H Timing Ratio Clear All

W Timing
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7. Klicken Sie auf die Schaltflache ,Run”
(Ausfuhren). @ :ﬁ’

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt.

@ 97.0mV Ofset:350m [e™ /5w 20ps  1000MSIs 1.0ns/pt

«» 7.0mv O Trig Diy: 184 events Ru Average:d
@7 97.0mV Offset:350mV ganoy 246 acas RL:20.0k

1.02V/div October 11, 2006

Results: Color Bars
Measured

1024x768_75Hz unit: v

Line Number
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Anzeige relativ zu Referenzfarbbalkenmessungen

Das System der Serie VM zeigt die Messergebnisse auf zweierlei Weise an: wie gemessen und in Bezug auf einen
Referenzwert. Der relative Wert wird durch Subtraktion des gemessenen Werts von einem Referenzwert berechnet. Um
Messergebnisse in Bezug auf einen Referenzwert anzeigen zu lassen, miissen Sie Enable Relative Results (Relative
Ergebnisse aktivieren) auf der Registerkarte Reference & Limits (Referenz & Grenzen) des Konfigurationshildschirms
auswahlen. Referenzwerte werden in speziellen Textdateien mit durch Komma unterteilten Werten (CSV) angegeben. Das
System der Serie VM enthalt einige Toleranzmaskendateien, die Sie bearbeiten konnen, sodass Sie die Referenzwerte lhrer

58

Anwendung entsprechend angeben kdnnen.

1.

Schalten Sie das Gerat ein.

Wéhlen Sie Analyze > VM HD and SD
Video (Datei > VM HD- und SD-Video)
oder VM VGA Video (VM VGA-Video).

Wéhlen Sie in der Anwendung

des Systems der Serie VM File

> Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurlickzusetzen.

Legen Sie ein Signal an die Eingange
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

Wabhlen Sie das Eingangssignalformat
aus. (Siehe Seite 33, Festlegen des
Eingangssignalformats — Optionen

0
0
0
0
o
0
0
0

0
0

00
QO ooo
0

8
o

O o 0lg

@

Qoo

@[o° 00 O
@|©eo
(@)

-
[—

Analyze |

Litiities | Help |

Restore Application
Wi HD and S0 Wideao

Wh S8 Wideo

BN Configuration  Resu

Recall Default Setup

Recall Setup...
Save Setup...
Minimize

Ewit

SD/HD.) (Siehe Seite 35, Festlegen des
Eingangssignalformats — Option VGA.)

Wabhlen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.
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7. Aktivieren Sie das Kontrollkdstchen ESHEEIten

[ Format | Measurements | tTp;awl Warnings | Reference & Limits | Pict

Enable Relative Result Display
(Anzeige von relativen Ergebnissen

Relative Result Display

aktivieren).

In der Standardeinstellung wahlt die Reference Selection
Anwendung des Systems der Serie VM © Cetaut

aus den verfiigharen Toleranzmasken eves

automatisch eine zum ausgewahlten
Signalformat passende Referenzdatei
aus.

8. Klicken Sie auf die Schaltflache ,Run”
(Ausfuhren).
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Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt. Beachten Sie, dass nun
die Registerkarten ,Relative” (Relativ)
und ,Reference" (Referenz) ausgewahlt
werden kénnen.

1000MS/s 1.0ns/pt
Average:4

RL:50.0k
2006 7:5

Results: Color Bars

HD 1080160

Line Humber

a Trg | pispiey | cursors | meas utities | weip [0}

@B 97.0mV Offsot:35 s I 1.0ns/pt
LD 97.0mV OFf

T 97.0mV Off RLi20.0k

TTH 1.02vidiv October 11, 2006

€ File Configuration Results Uliities Help

Option VGA
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9. Wabhlen Sie die Registerkarte Reference
(Referenz) aus, um die Referenzwerte
zum Berechnen der relativen Werte
anzeigen zu lassen.

Anwendungen

@B 138mV Offset:204m s 1000MSis 1.0nslpt

€D 96.0mVidiv
«D 9%.

Average:4
RL:50.0k

Results: Color Bars

HD 10801160

Line Humber

Option SD/HD

yee | vtities | weo [0}

q | Trg | Display | cursors

20ps  1000MS 1.0ns/pt

Ru A

1024 acgs RLi20.0k
October 11, 2006

Option VGA
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10. Wahlen Sie die Registerkarte Relative
(Relativ) aus, um die berechneten
relativen Werte anzeigen zu lassen.

Results Utiitas Haip

Resuits: Color Bars )
Fomat Measured | Relatve | Reforence [
HI 1080060 o
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11. Wahlen Sie die Optionsschaltflache
% aus, um die prozentuale Differenz
zwischen dem gemessenen Wert und
dem Referenzwert anzeigen zu lassen.

€D 96.0mVidiv
«D 9%.

Average:4
RL:50.0k

@B 138mV Offset:204m s 1000MS/s 1.0ns/pt ‘

Results: Color Bars

HD 10801160

Line Humber

Black Infin

a| Tig | Dispiay | cursors | Meas yee | vtities | weo [0}

1.0ns/pt

10 812 acq RLi20.0k
October 11, 2006 7

Black

Option VGA
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Anzeigen von Farbbalkenmessungen mit Grenzwertprufung

Das System der Serie VM kann Messergebnisse im Vergleich zu einem Grenzwert und mit einer Pass/Fehler-Angabe
anzeigen. Wie bei den relativen Messungen wird der Grenzwert in einer Textdatei mit durch Komma getrennten Werten
(CSV-Format) angegeben. Das System der Serie VM enthélt einige Toleranzmaskendateien, die Sie bearbeiten konnen,
sodass Sie die Grenzwerte Ihrer Anwendung entsprechend angeben kdnnen. Grenzwerte bestehen aus einem Maximalwert
und einem Minimalwert. Messwerte, die zwischen dem maximalen und dem minimalen Grenzwert liegen, haben die
Grenzwertprifung bestanden. Messwerte, die oberhalb des maximalen oder unterhalb des minimalen Grenzwerts liegen,
haben die Grenzwertpriifung nicht bestanden.

1. Schalten Sie das Gerét ein.
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2. Wahlen Sie Analyze > VM HD and SD e e |
Video (Datei > VM HD- und SD-Video) Analyze | Ltities | Helo
oder VM VGA Video (VM VGA-Video).

Restore Application

Wi HD and =0 Wideo

s YGA Yideo
3. Wahlen Sie File > Recall Default File Configuration Resu
Setup (Datei > Grundeinstellungen _RIEEE” Default Setup
abrufen) aus, um alle Einstellungen Recall Setup..
auf die werkseitigen Standardwerte Save Setup...
zurlickzusetzen. Minirmize

Option SD/HD

File Configuration Resu

Recall Default Setup

Recall Setup...
Save Setup...
Minirmize
Exit

Option VGA

4. Legen Sie ein Signal an die Eingdnge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)
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5. Wahlen Sie das Eingangssignalformat
aus. (Siehe Seite 8, Voraussetzungen
fir Eingangsverbindungen
— Optionen SD/HD.) (Siehe
Seite 8, Voraussetzungen fir
Eingangsverbindungen — Option
VGA.)

6. Wahlen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

7. Wahlen Sie Enable Limit Testing
(Grenzwertprufung aktivieren) aus.

In der Standardeinstellung wahit

die Anwendung VM5000 aus

den verfiigbaren Toleranzmasken
automatisch eine zum ausgewahlten
Signalformat passende Grenzwertdatei
aus.

8. Klicken Sie auf die Schaltflache ,Run”
(Ausfuhren).

Anwendungen

Configuration
[ Format | Measuramants | Dperat Vactor |

Relative Result Display Limit Testing

Caplure Results as Reference... omn Lir esting Faflure

Reference Selection Limits Selection

Option SD/HD

Configuration
| Format [ Measurements | Operation | Warnings |

lative Result Display Limit Testing

Capture Results as Reference. .

Raferance Selection

Option VGA

Configuration

| Format [ Measurements | Operation [ Warnings |Refe | Picture & Vector

elative Result Display Limit Testing
B Enzble Limi

Capture Results as Reference. . Stop on Limit Test

Raferance Selection Limits Salection

| ccectiimnrie |
Option SD/HD

Configuration
| Format [ Measuremonts | Operation | Warnings ||

Relative Result Display Limit Testing

M Enable Relat play

Capture Results as Reference. .

Reference Selection Limits Selection

Option VGA

@ x|
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66

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt. Beachten Sie, dass nun
die Registerkarte ,Limits* (Grenzwerte)
ausgewahlt werden kann.

Wenn die Grenzwertpriifung aktiviert ist,
werden die Ergebnisse in grlin oder rot
formatiertem Text angezeigt. Griiner Text
bedeutet, dass die Priifung bestanden
wurde (der Messwert hat die Grenzwerte
nicht Giberschritten). Roter Text bedeutet,
dass die Priifung nicht bestanden wurde
(der Messwert hat den maximalen
Grenzwert (iberschritten bzw. den
minimalen Grenzwert unterschritten).

@B 138mV Offset:204m!

7D 96.0mVidiv
T 98.5mVIdiv
TTD 165mv OFf

& File Configuration R
Results: Color Bars

HD 1080160

Line Humber

Option VGA

Rui Average:4

10 284 acqs RLi50.0k
November 07, 2006

|[ 5.0us  1000ms/s 1.0ns/pt ‘

esults Utilties Help

Measured

unit: mv/

RLi20.0k

1.0ns/pt
October 11, 2006

Measured

unit my

Schnellstart-Benutzerhandbuch flir Videomesssysteme der Serie VM



Anwendungen

9. Wahlen Sie die Registerkarte Limits
(Grenzwerte) aus, um die verwendeten
Grenzwerte anzeigen zu lassen.

Wahlen Sie entweder min oder max
aus, um die fiir die minimal und maximal
zulassigen Werte angegebenen Grenzen
anzeigen zu lassen.

@B 138mV Offset:204m |[ 5.0us  1000msis 1.0nslpt

€ 96.0mVidiv Ru Average:4
@ 98.5mVidiv 9869 acqs RL:50.0k
@D 165mv OFf

€ File Configuration Results Utiities Help

Results: Color Bars
[ Measured

HD 10801160

Line Humber

Option SD/HD

3426 acgs RLi20.0k
October 11, 2006 6

1.0ns/pt ‘

Results: Color Bars

— Format
68_75Hz

Option VGA
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Grenzwertprufung mit zwei Messungen

Das System der Serie VM kann Grenzwertpriifungen mit mehr als jeweils einer Messung vornehmen.

1. Schalten Sie das Gerét ein.
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2. Wabhlen Sie Analyze > VM HD and SD R
Video (Datei > VM HD- und SD-Video) Analyze | Ltities | Help
oder VM VGA Video (VM VGA-Video).

Restore Application
Wi HD and S0 Wideao
W WA Video

Option SD/HD

3. Wahlen Sie File > Recall Default

- : File Configuration R
Setup (Datei > Grundeinstellungen Dile  Lonfiguration - mesu

abrufen) aus, um alle Einstellungen Fecall Default Setup
auf die werkseitigen Standardwerte Recall Setup
zuriickzusetzen.

Save Setup...

Minirmize

Euxit

4, Legen Sie ein Signal an die Eingdnge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

5. Wahlen Sie das Eingangssignalformat
aus. (Siehe Seite 33, Festlegen des
Eingangssignalformats — Optionen
SD/HD.) (Siehe Seite 35, Festlegen des
Eingangssignalformats — Option VGA.)
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6. Wahlen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

7. Wahlen Sie Enable Limit Testing
(Grenzwertprifung aktivieren) aus.

In der Standardeinstellung wahlt

die Anwendung VM5000 aus

den verfiigbaren Toleranzmasken
automatisch eine zum ausgewéhlten
Signalformat passende Grenzwertdatei
aus.

8. Klicken Sie auf die Registerkarte
Measurements (Messungen), um die
auszufilhrende Messung auszuwahlen.

Anwendungen

Configuration
| Format | Measuraments | Dpe srence & Limits | Pi actor |

Relative Result Display Limit Testing

Capture Results as Reference...

Reference Selection Limits Selection

Option SD/HD

Configuration
| Format [ Measurements | Operation [ Warnings |

Relative Result Display Limit Testing

Blative it N
Capture Results as Reference. .

Reference Selection
@ Default
LA

Option VGA

Configuration
[ Format [ Measurements | Operaiion | Warmings [Hu:l

Relative Result Display

| Picture & Vector

Limit Testing
M Enable Relatn

Capture Results as Reference. .

Raferance Selection

Option SD/HD

Configuration

[ Format [Measurements Operation Wamings Reference & Limits

Relative Result Display Limit Testing

Ena Enable Limit Testing

Capture Results as Reference....

Reference Selection Limits Selection

@ Defaul

Option VGA
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9.

10.

Wahlen Sie zwei Messungen aus:

Option SD/HD: Aktivieren Sie Color

Configuration

BaI'S (Fal’bba|ken) Und H Sync ‘\'Fnlmal Measuremghts | Operation [ Warnings |Reference & Limits [ Picture & Vector
(Synchronisation). 5 bt

Clear All

2091072

Option VGA: Aktivieren Sie Color
Bars (Farbbalken) und Luma Levels
(Luminanzstufen). i

Klicken Sie auf die Schaltflache ,Run*
(Ausflihren).

Wenn die Messungen beginnen, wird der
Bildschirm fiir den Messstatus angezeigt.
Wenn die Messungen abgeschlossen
sind, wird fiir die ausgewahlten
Messungen ,Pass" (Bestanden) oder
,Fail* (Fehler) angezeigt.

|[ 5.0ps  1000msis 1.0nsfpt

Sample

781 acqs RL:50.0k
06 5:5

Option SD/HD
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@B 97.0mV Off
€» 97.0mv Off

Qo™ 163V 20ps  5.06S/s 200psipt

i 83 events Ru sample
B\ 2 416 acqs RL:100k
October 11, 2006 1

Warnings
ﬂ

@D 97.0mv Off
TID 1.02vidiv

& File Configuration Results Utiiies Help

Status Warnings Status

Color Bars

Luma Levels

Option VGA

11. Um die Ergebnisse fiir die einzelnen
ausgewahlten Messungen anzuzeigen,
klicken Sie auf das Menii Results
(Ergebnisse), und wahlen Sie eine der
Messungen aus.

Der Ergebnisbildschirm fir die
ausgewahlte Messung wird angezeigt.

utites | wetp [[FR)

Results: Golor Bars

Measured

HD 1080160 unit: my*

Option SD/HD
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Qo™ S 163v 20ps  5.0GSls 200psipt

Trig Diy: 383 events Ru sample
B\ 22v 16 RL:100k

Results: Luma Levels
Measured

1024768 _75Hz unit: my

ine Number

Option VGA
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12. Um die Ergebnisse fir die andere
ausgewahlte Messung anzuzeigen,
klicken Sie auf das Meni Results
(Ergebnisse), und wahlen Sie die andere
Messung aus.

Results: H Sync

HD 1080160

Line Humber

@ 97.0mV Off

& 57.0mv Off

@D 97.0mv Off
1.02V/div

Results: Golor Bars

— Fomat
8_75Hz

Option VGA
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50ps  1000MSIs

yze | vtites | Hein |}

200psipt

3159 acqs RL:100k
October 11, 2006 6:10:02

Measured

unit: my*
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Ausfuhren von Messungen uber mehrere Zeilen

Bei Messungen mit dem System der Serie VM wird mit der Zeilennummer angegeben, an welcher Stelle (bzw. wann) die
Messung vorgenommen wird. (Wenn Sie die Luminanzstufe messen méchten, miissen Sie sicherstellen, dass die Messung
innerhalb des aktiven Videobereichs des Signals vorgenommen wird.) Gelegentlich miissen Sie eine Messung (iber mehrere
Zeilen ausfiihren. (Beispielsweise miissen Sie moglicherweise Uberpriifen, ob die Pegel vom oberen Ende bis zum unteren
Ende des Bildschirms konsistent ist.) Verwenden Sie dazu die Einstellung Multi Lines (Mehrere Zeilen) unter Line Select
(Zeilenauswahl) auf der Registerkarte Operations (Vorgange).

HINWEIS. Einige Messungen sind im Modus ,Multiple Lines” (Mehrere Zeilen) nicht verfiigbar.

Da Sie angeben kénnen, dass Messungen fiir jede Zeile vorgenommen werden, erhalten Sie méglicherweise eine Vielzahl
von Messergebnissen. Deshalb werden die Ergebnisse aller im Modus Multi Lines (Mehrere Zeilen) ausgefiihrten
Messungen nicht auf dem Bildschirm angezeigt, sondern in einer Datei gespeichert. Die Ergebnisdatei kann im Format
RTF, CSV oder PDF gespeichert werden. Um die Ergebnisse einer Messung im Modus Multi Lines (Mehrere Zeilen)
abzurufen, missen Sie anstelle der Anwendung fiir das System der Serie VM eine der Anwendungen Microsoft Word, Excel
oder Adobe Reader verwenden.

1. Schalten Sie das Gerét ein. [ r—w—
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2. Wahlen Sie Analyze > VM HD and SD _ il
Video (Datei > VM HD- und SD-Video) Analyze | Ltities | Help |
oder VM VGA Video (VM VGA-Video).

Restore Application

Wi HD and =0 Wideo

Whi W8 Wideo

3. Wahlen Sie in der Anwendung File Configuration Resu
des Systems der Serie VM File
> Recall Default Setup (Datei >

Recall Default Setup

Grundeinstellungen abrufen) aus, um Recall Setup...
alle Einstellungen auf die werkseitigen Save Setup..
Standardwerte zuriickzusetzen. Winimize

Exit

4. Legen Sie ein Signal an die Eingange
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)
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5. Wahlen Sie Configuration >
Format (Konfiguration > Format),
und nehmen Sie die gewiinschten
Formateinstellungen vor.

6. Wahlen Sie Configuration > Operations Configuration  Results
(Konfiguration > Vorgénge) aus. = =
Format
Measurements

Dperation
Warnings
Reference & Limits

Option VGA

7. Klicken Sie im Bereich ,Line Select* Configuration
(Zeilenauswahl) auf Multi Lines [Format [Measurements | Operation [Wamings | Reference & Limits | Picture & Vector

(Mehrere Zellen) Setup And/Or Run Run Mede Auto Scale Sync/Trigger

[ Enanled

Initial Yalues
@ Fun Onily

t Ry Line Select

E
Restore Default

Option SD/HD

Configuration
[Format [ Measurements [ Operation [Wamings |Reference & Limits
Setup AndiOr Run Run Made Line Select Auto Scale
d

Initial Values

& Run Only

RGBHV MIU Sync Polarity Report Madle

Use MIL [ Auto Detect I Capture Restare Default

Option VGA
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8. Zur Angabe der Messungen und der
Zeilen, auf denen die Messungen
genommen werden sollen, wéhlen
Sie die Registerkarte Measurements
(Messungen).

Fir jede Messung sind zwei
Eingabefelder vorhanden: ,Start
Line* (Anfangszeile) und ,End Line"
(Endzeile). Verwenden Sie diese
zwei Felder, um den Zeilenbereich
anzugeben, Uber den die Messung
erfolgen soll.

9. Um eine auszufilhrende Messung
auszuwahlen, aktivieren Sie das

Kontrollk&stchen neben der Messung.

10. Geben Sie die Zeilennummern in die
Felder Start Line (Anfangszeile) und
End Line (Endzeile) ein.

76

Cenfiguration

(Format | Measurements | Operation [ Warnings [ Reference & Limits [ Picture & Vector

Measurements on Multiple Lines
EndLine

Configuration

[Format 'Measurements [ Operation | Warnings [Reference & Limits

Measurements oh Multiple Lines

Start Line End Line

Color Bars

Ch-Ch

W H Timing
[ Color Ba

Cenfiguration

[Format [Measurements "Operation [ Warnings [Reference & Limits

Measurements on Multiple Lines

Start Line End Line

HTI
Color

Ch-Ch
Option VGA

Cenfiguration

(Format |Measurements | Operation [ Warnings [ Reference & Limits

Measurements on Multiple Lines

Start Line Enhd Line

Option VGA
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Start Line

Start Line

Start Line
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EndLine

End Line
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Anwendungen

Nachdem Sie die gewiinschten
Messungen ausgewahlt haben, miissen
Sie den Namen der Datei angeben, in
der die Messergebnisse gespeichert

werden.
11. So geben Sie die Parameter der Datei Bl D R ,
an, in der die Ergebnisse gespeichert o e
an in d OmE e Name - PPN e
. ® FOF
= Kiicken Sie auf Utilities Descpten B s —
(D|enstprogramme) > Generate Measurements Recent Reports

Report (BeriCht generieren)_ @ Al ©WhAppSIOpiVGAReports|Galor Bars and Luma Levels.if
i 1 LB ed
Darauthin wird das Fenster zum

Generieren eines Berichts angezeigt.

12. Klicken Sie auf Browse (Durchsuchen),
um den Dateinamen und den Speicherort
zu andern. Daraufhin wird das Dialogfeld
Save (Speichern) angezeigt.

13. Geben Sie den Dateinamen ein,
oder navigieren Sie in das gewUlinschte
Verzeichnis, in dem die Datei gespeichert (3 vewror
werden soll. 1) My Documents

g My Computer
g Local Disk (C2)
[== WhApps

[= OptveA

;l-:& Save Report

My Recent b

My Documents

My Computer

My Nebworc .. [
File name Color Bars and Luma Levels.if Sae
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78

14. Wahlen Sie das Format des Berichts aus
den unter Files of type (Dateien vom
Typ) aufgelisteten Formaten aus.

15. Klicken Sie auf Save (Speichern).

16. Option VGA: Wenn Sie eine
Bildschirmaufnahme des Signals
im Bericht speichern mdchten, wéhlen
Sie Configuration (Konfiguration)
>Operations (Vorgange) aus, um das
Fenster fir Vorgdnge anzuzeigen.
Aktivieren Sie Embed Screen Shot
(Bildschirmaufnahme einbetten) unter
Report Mode (Berichtsmodus). Diese
Option ist nur verfiigbar, wenn Files of
type (Dateien vom Typ) auf Rich Text
Format festgelegt wurde.

My Recent D |Z Color Bar and Luma Levals.ttf

€

My Documents
My Computer
Wiy Netwark

: Calor Bars and Luma Levals.rif Save

Al Files

Configuration
[Format [ Measurements ‘Operation [ Warnings [Reference & Limits
Setup And/Or Run Run Mode Line Select Auto Scale
d

Initial Values

@ Fun Only

RGBHY MIU Sync Polarity Repart Mode

Use MU Auto Detect ture Restare Defallt

Option VGA
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17.

18.

Klicken Sie auf die Schaltflache Run
(Ausfiihren), um die Messungen
auszufihren.

Nachdem Sie auf Run (Ausfiihren)
geklickt haben, wird die Ergebnisseite
fir die erste ausgewahlte Messung auf
dem System der Serie VM angezeigt,
und die Messungen beginnen. Die
angezeigte Zeilennummer wird mit jeder
abgeschlossenen Messung groRer, bis
die Messung fir alle angegebenen Zeilen
ausgefthrt wurde. Der Vorgang wird flr
jede ausgewahlte Messung wiederholt.

Um die Messergebnisse anzuzeigen,

Anwendungen

ZH Color Bars and Luma Levels.rtf - Microsoft Word

EBIX

Oﬁnen Sle dle BerIChtSdatel mlt der File Edit View Insert Format Tools Table \Window Help Nitro PDF
entspreChenenden AnWendung WordSmith  Adobe PDF  Acrobat Comments X
NSEan SRy Y- [@ED ™ @ 2isonr?
o %, - §) .  Momal +12pt - TimesMNewRoman - 12 - B I O £ A2
A
L §|1|(||4|= e A L
VM VGA Video - Measurements Results Report
Color Bars and Luma Levels
- October 11, 2006 05:11 PAL
3 Instrument: DPOT7254,Q360,CF:9L1CT FV:1.0.90 devBuild 62, Software Version:
- 0.99.RC1 p—
- Resolution: 1024x768 Refresh Rate: T3Hz Timing Standard: DAMT
- Reference File: NONE
Z Limits File: C:'VAMApps'OptVGA RefLimFiles DMT DefaultLimits1024X768@ 75-
RGB.csv
Autoscale: On Stop On Limit Error: Off
~ MIU: Used Svnc Polarity Auto Detection: Enabled
'_
R [ STARERY: | | Wamings |
- Color Bars [ I | |
y u}
Caolor Bars
- Line: 184  Average: 1
B Color Bars B
+ White 5715
N Yellow
- Cyan
- Green
B Alagenta
Red
w Elue
. Elack
r
.
N z
Color Bars @
. F
= s[E= 4 |
Page 1 Sec 1 /4 At 17 Ln 1 Co 1
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Anwendungen

Anzeigen des Eingangssignals als Bild

Das System der Serie VM kann das Eingangssignal als Bild anzeigen.

80

1.

Schalten Sie das Gerat ein.

Wabhlen Sie Analyze > VM HD and SD
Video (Datei > VM HD- und SD-Video)
oder VM VGA Video (VM VGA-Video).

Legen Sie ein Signal an die Eingénge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

Klicken Sie auf die Schaltfliche
mit dem Bild. Daraufhin wird das
Videomonitorfenster angezeigt.

Klicken Sie auf die Schaltflache zum
Maximieren, um das Bild auf den
gesamten Bildschirm zu vergréRern.

@

Analyze | Utilities | Help n

VM HD and SD Video %
VM VGA Video
WMS000 HD and 3D Video

VMBD0D VGA Video

Tektronix - YM Series Video Monitor
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Anzeige des Eingangssignals in einem Vektorskop-Fenster — Nur Optionen
SD/HD

Mit dem System der Serie VM kann das Eingangssignal in einem Vektorskop-Fenster angezeigt werden, sodass Sie sofort
den Farbbereich des Signals sehen kénnen.

1. Schalten Sie das Gerét ein. ——

coOodODpoo

CC:OOO
@ o o o o
O 000

2. Wahlen Sie Analyze > VM HD and | analyze | tiities | Help |
SD Video (Analysieren > VM HD- und
SD-Video).

VM HD and S0 Video %
VM VGA Video
WMS000 HD and 3D Video

VMBDD0 VGA Video

3. Legen Sie ein Signal an die Eingange
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

Schnellstart-Benutzerhandbuch fiir Videomesssysteme der Serie VM 81
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4. Klicken Sie auf die Schaltfldche |
,Vectorscope® (Vektorskop). @ %
Daraufhin wird das Videomonitor-

Anzeigefenster angezeigt.

5. Klicken Sie auf die Schaltflache zum
Maximieren, um die Vektorskopanzeige
auf den gesamten Bildschirm zu

verg rolkern [ vektronix - vM5000 Video Monitor
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A

Anfangszeilennummer
Matrixsignal, 54
Anzeigen von Messergebnissen, 42
Ausfilhren einer Messung, 42
Austauschzubehdr, 40
Auswahlen von Messung en, 37
LAuto Scale" (Automatisch skalieren)
Schaltflachen, 40

B

Betriebsspezifikationen, 4
Bildanzeige, 80

D

Darstellung der Frontplatte, 6
Darstellung der Riickplatte, 7
Darstellung der Seitenplatten, 7
Dokumentation, vi

E

Eingangssignalformat
festlegen, 33, 35
Eingangsvoraussetzungen, 8

Einstellung
Warnungen, 41

F

Fehler- und Warnmeldungen, 44
Festlegen
Ausfiihrungsoptionen fir
Messungen, 38
Eingangssignalformat, 33, 35
Frontplatte, 6

G

Grenzwertpriifung, 64, 68

K

Kalibrierung, 21

Matrixsignal
Beschreibung, 25
Matrixsignalmuster
Anfangszeile, 54
Mehrere Zeilen, 74
Meldungen, 44
Messungen
ausfiihren, 31
auswahlen, 37

N

Netzwerkverbindung, 5

0]

Operationen
festlegen, 38
Optionschaltflachen ,Channel 1/4*
(Kanal 1/4), 40
Optionsschaltflache ,Continuously*
(Fortlaufend), 39
Optionsschaltflache ,Once & Report*
(Einmal & Bericht), 39
Optionsschaltflache ,Run Only* (Nur
Ausfiihren), 39
Optionsschaltflache ,Setup & Run®
(Setup & Ausfiihren), 39
Optionsschaltflache ,Setup Only*
(Nur Setup), 39
Optionsschaltflachen
LAuto Scale Enabled*
(Automatische Skalierung
aktiviert), 40
Betriebsmodus, 39
,Channel 4* (Kanal 4), 40
,continuously*
(Fortlaufend), 39
,Once & Report* (Einmal &
Bericht), 39
,Once* (Einmal), 39
,Run Only* (Nur ausfiihren), 39
,oetup & Run® (Setup &
Ausfiihren), 39
,oetup Only* (Nur Setup), 39
Oszilloskop
verwenden, 43
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P

Pass/Fehler-Tests, 64

R

Relativ zu Referenzmessungen, 58
RGBHV-Messschnittstelleneinheit
Verbinden, 14

S

Schaltflachen
LApp* (Anwendung), 30
LExit* (Beenden), 30
,Hide" (Ausblenden), 29
LPicture” (Bild), 29
,Run” (Ausfiihren), 29
,Stop” (Anhalten), 29
,Vektorscope® (Vektorskop), 29
Sicherheitshinweise, iii
Signale
Verbinden, 9
Softwareaktualisierungen, vi
Spezifikationen
In Betrieb, 4
Stromversorgung, 4
Standardzubehor, 1,3
Stromversorgung
Voraussetzungen, 4
Sync-Pickoff
Kompensation, 21
Verbinden, 9
Sync-Pickoff kompensieren, 21

.

Typen ausgegebener
Warnungen, 41

U

Unterstlitzte Instrumente, v

Unterstlitzte Oszilloskope, v

,2User-Defined Format*
(Benutzerdefiniertes Format)
erstellen, 34, 36
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vV

Vektorskopanzeige, 81
Verbindung von Signalen, 9
Verwenden des Oszilloskops, 43
VESA-Prifverfahren

Version, 31
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W Z

Warn- und Fehlermeldungen, 44 Zeilennummer
Weiterfilhrende Dokumentation, vi Anfang, 54
Zubehor
Standard, 3

Schnellstart-Benutzerhandbuch flir Videomesssysteme der Serie VM



	toc
	Allgemeine Sicherheitshinweise
	Vorwort
	Hauptfunktionen
	Unterstützte Produkte
	Dokumentation
	Softwareaktualisierungen
	In diesem Handbuch verwendete Konventionen

	Installation des Geräts
	Standardzubehör
	Empfohlenes Zubehör
	Betriebsvoraussetzungen
	Einschalten des Geräts
	Ausschalten des Geräts
	Abziehen des Netzkabels
	Verbindung zu einem Netzwerk herstellen

	Umgang mit dem Gerät
	Vorderseite
	Seitenplatten und Rückplatte
	Voraussetzungen für Eingangsverbindungen – Optionen SD/HD
	Voraussetzungen für Eingangsverbindungen – Option VGA
	Verbinden von Eingangssignalen
	Signalpfadkompensation
	Sync-Pickoff-Kompensation – Serien VM6000 und DPO7000, nur Optio
	Sync-Pickoff-Kompensation – Serien VM5000 und TDS5000, nur Optio
	Informationen zum Matrixtestsignal
	Starten der Systemsoftware der Serie VM
	Die Benutzeroberfläche der Serie VM-Software
	Verfahren zum Ausführen von Messungen
	Konfigurieren des Prüflings – Option VGA
	Festlegen des Eingangssignalformats – Optionen SD/HD
	Festlegen des Eingangssignalformats – Option VGA
	Auswählen von Messungen
	Festlegen der Ausführungsoptionen für Messungen
	Ausführen und Anzeigen von Messungen
	Verwenden des Oszilloskops
	Fehlerbehebung bei Signalproblemen

	Anwendungen
	Einfache Farbbalkenmessung – Optionen SD/HD
	Einfache Farbbalkenmessung – Option VGA
	Anzeige relativ zu Referenzfarbbalkenmessungen
	Anzeigen von Farbbalkenmessungen mit Grenzwertprüfung
	Grenzwertprüfung mit zwei Messungen
	Ausführen von Messungen über mehrere Zeilen
	Anzeigen des Eingangssignals als Bild
	Anzeige des Eingangssignals in einem Vektorskop-Fenster – Nur Op




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Average
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /SyntheticBoldness 1.000000
  /Description <<
    /FRA <>
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /ENU <>
  >>
>> setdistillerparams
<<
  /HWResolution [1200 1200]
  /PageSize [612.000 792.000]
>> setpagedevice




